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EASY-ROB™ Bedienungshinweise 

Einleitung 

Übersicht der Dokumentation und die Installation 

 

 
Die Bedienungshinweise werden Sie bei der Arbeit mit EASY-ROB™ unterstützen. Die Bedienungshinweise 
enthalten detaillierte Information die erforderlich sind, um die Software mit allen Funktionalitäten von Anfang 
an richtig zu nutzen. 
 
Neben Informationen über die System-Dateien für die grundsätzliche Konfiguration bzw. das 
Erscheinungsbild, gibt es Beschreibungen über die Short Keys oder die Hauptdialoge und ein paar kurze 
Tutorials. 
 
Für die optimale Unterstützung nutzen Sie bitte die gesamte verfügbare Dokumentation zu EASY-ROB™. 
 
Liste der existierenden Dokumentation : 

- Produktbeschreibung 
(Allgemeine Beschreibung aller EASY-ROB™- Produkte, Optionen  und API’s) 

- Bedienungshinweise 
(Wie nutzt man EASY-ROB™. Detaillierte Beschreibung zu System-Dateien, Funktionen und 
Dialogen) 

- EASY-ROB-ERPL 
(Referenz zu ERPL- und ERCL-Sprache) 

- TrainLib-Tutorial 
(Schulungsunterlagen)  

- Installationsanleitung  
(Detaillierte Beschreibung für die gesamte Installationsprozedur) 

 
 
Bitte installieren Sie auch die folgenden Bibliotheken: 

- TRAINLib (Schulungsbibliothek)  
(Die Schulungsbibliothek unterstützen den Bediener bei den ersten Schritten in EASY-ROB™ von 
der leeren Arbeitszelle bis zur Simulation) 

- Beispielordner “Proj_example_erpl”  
(Die Beispiele zeigen die Anwendung der ERPL- und ERCL-Sprache) 

 
 
Installation: 
Für die Installation von EASY-ROB™ folgen Sie den Anweisungen des Dokuments “Installationsanleitung”. 
Darin ist die gesamte Installationsprozedur detailliert beschrieben. 
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EASY-ROB™ Bedienungshinweise 

Einleitung 

Inhalt der Installations-CD 

 

Im Hauptverzeichnis befinden sich die Installationsprogramme für die folgenden  
EASY-ROB™-Produkte 
 

• Installationsanleitung.pdf Anleitung zur Installation von EASY-ROB™ 

• EASY-ROB App Setup x64.exe EASY-ROB™ App Professional, Education Version 

• EASY-ROB LicenseManager Setup.exe EASY-ROB™ Lizenz Manager 

• EASY-ROB Viewer Setup x64.exe kostenfreie EASY-ROB™ Viewer Version 

• EASY-ROB Demo Setup x64.exe kostenfreie EASY-ROB™ DEMO Version 
Installationsanleitung-DEMO.pdf mit Anleitung zur Installation 
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Inhalt der Installations-CD 
 
 

Unterverzeichnisse: 

 
• /Easy_Rob_EROSA EASY-ROB™ Offene Softwarearchitektur mit  

 API Beispielen als Microsoft® Visual Studio 2017 
Project 

• /Easy_Rob _Kernel Beispiele und Dokumentationen zum  
 EASY-ROB™ Kernel 

• /Easy_Rob_Updates Update Archive für die folgenden Produkte 

o /Easy_Rob_Framework_Update EASY-ROB™ Framework 

o /Easy_Rob_LicenseManager_Update EASY-ROB™ Lizenz Manager 

o /Easy_Rob_App_Update EASY-ROB™ App Professional, Education Version 

o /Easy_Rob_Kernel EASY-ROB™ Kernel 

o /Easy_Rob_Viewer_Update EASY-ROB™ Viewer Version 

o /SystemFilesTemplate Vorlagen für Systemdateien (config.dat, easy-rob.pth, 
...) 

• /Easy_Rob_Viewerx64 kostenfreie EASY-ROB™ Viewer Version 

• /EasyEdit-Offline-Programm-Editor EasyEdit™, eine kundenspezifische Lösung von  
 b+m surface systems GmbH (OLP für 
Lackierprogramme) 

• /Famos-Demoversion V9 Famos robotic® Demoversion von carat robotic GmbH, 
verwendet den EASY-ROB™ Kernel 

• /Foxit-PDF-Reader Foxit-PDF-Reader® zum Lesen von PDF-Dateien 

• /Manual Beispiele und Beschreibungen als PDF-Dokumente 
wie  
 Bedienungs-Hinweise.pdf, EASY-ROB-ERPL_DE.pdf 

• /Options VRML-Examples.zip mit Beispielen zur Konvertierung  
 von VRML II,97 -Dateien in das IGP-Format und  
 anschließender Optimierung „merge“. 
 CAD-Import.zip: IGES-, STEP-, VRML-Import-
Beispiele 

• /Product-Info PDF-Dokumente zur EASY-ROB™ Product Suite 

• /RobotLib Vollständige Roboterbibliothek 
 ABB, KUKA, Stäubli, Fanuc, Yaskawa 
 b+m, Comau, Mitsubishi, Universal Robots… 

• /SystemDlls Microsoft® Visual C++ Redistributable 2017 

• /TeamViewer TeamViewer für Präsentation und Remote-Support 

o TeamViewerQJ*.exe Startet EASY-ROB™ TeamViewer QuickJoin 

o TeamViewerQS*.exe Startet EASY-ROB™ TeamViewer QuickSupport 

• /WibuKey Setup für WibuKey & CodeMeter Dongle Treiber 
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EASY-ROB™ Bedienungshinweise 

System Dateien 

Environment Datei: easy-rob.env 

 

 
Die Environment Datei “easy-rob.env” enthält alle Initialeinstellungen für die Erscheinung / das Aussehen 
von EASY-ROBTM und wird automatisch bei jedem Start von EASY-ROBTM geladen. 
Außerdem kann der Bediener die Environment Datei mittels eines ERC-Kommandos während einer 
Simulation laden und somit die Einstellungen ändern. 
 
Die Datei enthält z.B. Variablen um  

- den Fußboden ein- oder auszuschalten  
- die Hintergrundfarbe zu verändern  
- den Style der Toolbars zu ändern 
- Clipping Planes zu setzen 
- etc.  

 
Mit einer “eigenen” Environment Datei kann jeder Bediener das EASY-ROBTM mit den „eigenen“ 
bevorzugten Einstellungen starten und nutzen. 
 
Die Variablen verändern kann der Bediener auf zwei verschiedenen Wegen:  

a) Editieren der Datei „von Hand“  
b) Ändern der Einstellungen in der Anwendung und abspeichern der Datei 

 
Um die Datei zu editieren kann der Bediener  
 den Tastenkombination verwenden : “Alt+Shift+E” 
 
 oder das Menü nutzen:    File Menu ->Edit-> EASY-ROB System files->  „Environment file“ 
 
 
Um die Umgebung nach Änderungen in EASY-ROB im Environment File zu speichern: 
 
 File Menu ->Save-> „Environment file“ 
 
 
 
Anmerkung: 
Ein Ausrufezeichen ( ! ) am Anfang einer Zeile in der Systemdatei steht für eine Kommentarzeile. Sie 
können jeglichen Kommentar in diese Zeile schreiben – sie wird bei der Ausführung ignoriert. 
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Environment Variablen 
 

Kommando und Syntax Gültige Werte Beschreibung 

FLOOR_ON  0; 1 Aus-/ Einschalten des Bodens 

FLOOR_WIRE_ON 0; 1 Aus-/ Einschalten des Bodens als Drahtmodell 

FLOOR_LENGTH 0.100000 ….. 25.000000 Länge des Bodens  [m] 

FLOOR_DLENGTH 0.100000 ….. 25.000000 Länge eines Quadrats des Bodens  [m] 

FLOOR_POSITION  X Y Z RX RY RZ 
X, Y, Z : +/- 0.000 ….. ~ 
RX, RY, RZ : +/- 0.00 …. +/-180.00 

Position des Bodens bezogen auf Welt Null 
X,Y,Z [mm]; RX,RY,RZ [deg] 

Tipp: 
Nutzen Sie die Funktion um den Boden zu 
verschieben, wenn der Nullpunkt der 
Arbeitszelle nicht auf dem Boden liegt.  

FLOOR_COLOR  0.0...1.0     0.0...1.0     0.0...1.0 

0.0...1.0 

Farbe des Bodens [R  G  B ] 
 
Beispiel: 
FLOOR_COLOR   0.6800   0.6850   0.6850 

BACKGROUND_COLOR  0.0...1.0     0.0...1.0     0.0...1.0 Farbe des Hintergrunds [R  G  B ] 
 
Beispiel: 
BACKGROUND_COLOR   0.0050   0.0000   
0.3200 

HITHER 0.020000 0.000500 ….. 4.000000 Setzen der „vorderen“ Clipping Plane [m] 

YONDER 20.000000 1.000000 ….. 200.000000 Setzen der „hinteren“ Clipping Plane [m] 

VIEW_STEPS   1 ….. 100 Setzen View Schrittweite 

TOOLTIPS 0; 1 Ein-/ Ausschalten der Tips, die beim 
überfahren mit dem Mauszeiger angezeigt 
werden. 

COI_ON 0; 1 Ein-/ Ausschalten des Center Of Interest. 

2_MOUSE_BUTTONS 0; 1 Aus-/ Einschalten der 2-Knopf-Maus  
 
Tipp: 
Setzten Sie die Variable auf „1“ (Einschalten), 
wenn Sie eine 2-Knopf-Maus verwenden. Die 
mittlere Maustaste wird dann über das 
gleichzeitige drücken der linken und rechten 
Maustaste realisiert. 

MONI_MSG_OUTPUT 0; 1 Aus-/ Einschalten Monitoring MSG 
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Environment Variablen 
 

Kommando und Syntax Gültige Werte Beschreibung 

S3DM_MENU 0; 1 Aktiviert/deaktiviert Space Mouse Menu 

S3DM_SPEED 1.0 Space Mouse Empfindlichkeit 

S3DM_THRESHOLD 1.0 Space Mouse Schwellwert 

M_TO_UNIT 1000.000 mm  
1.000000 m 
39.370079 inch 

Bedienerdefinierte Einheiten 
 
Die interne EASY-ROBTM--Einheit ist “Meter”. 
Die Variable “M_TO_UNIT” definiert in 
welcher Einheit alle Werte im EASY-ROBTM  
dargestellt werden. 
(1m = 1000mm = 39.37inch) 
Beispiel: 
M_TO_UNIT 1000.000000 mm   -> alle 
Werte werden in “mm” dargestellt 
M_TO_UNIT 39.370079 inch   -> alle Werte 
werden in “inch” dargestellt 
 
(siehe auch Menü -> View: ->Graphic View 
Data) 

REMOTE_MSG_OUTPUT 0; 1 Aus-/ Einschalten  von „Remote messages“ 
im Message Window  

REMOTE_TRACE_FILE  REMOTE_TRACE_PRG.PRG Wenn eine „Remote-Verbindung“ besteht, 
werden die Remote-Kommandos in der Datei 
gespeichert 

EXPORT_FILE  0; 1 Aus-/ Einschalten der Exportfunktion für 
Arbeitszellen  
(Die Funktion exportiert alle beteiligten Parts 
einer Arbeitszelle beim Speichern. So kann 
sichergestellt werden, dass alle notwendigen 
Teile für z.B. einen Datenaustausch 
zusammen sind.  
(siehe auch Bedienungshinweise) 

ENABLE_RUNTIME 0; 1 Aus-/ Einschalten der RunTime-Funktion für 
Arbeitszellen  

TOOLBAR_MODE 2; 0; 1 Ändern des Toolbar Styles 
0-Standard Icons  
1-Neue Icons Normal 
2-Neue Icons Hot (dies ist Default) 

SHOW_TAG_CONNECT 0; 1 Aus-/ Einschalten „Verbinde alle Tags im 
aktuellen Pfad“ 
(siehe Bedienungshinweise -Tag Window) 
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Environment Variablen 
 

Kommando und Syntax Gültige Werte Beschreibung 

SHOW_TAG_TEXT 0; 1 Aus-/ Einschalten der Darstellung des 
Namens aller Tags im aktuellen Pfad 
(siehe Bedienungshinweise -Tag Window) 

TAG_APPROACH_DIREC
TION 

1;-1;2;-2;3;-3  1 use  x direction for picked normal 
-1 use -x direction for picked normal 
 2 use  y direction for picked normal 
-2 use -y direction for picked normal 
 3 use  z direction for picked normal 
-3 use -z direction for picked normal 

GRAD_BCKGND 0; 1 Aus-/ Einschalten des graduierten 
Hintergrund 
Empfehlung:  Setzen Sie “GRAD_BCKGND 
0” (OFF), wenn die Grafikkarte 
„unterdurchschnittlich“ ist. 

STOP_UNREACH 0; 1 Aus-/ Einschalten „Stoppe bei unerreichbarer 
Position“  
(siehe Menü-> Simulation -> Run Settings) 

STOP_SWE 0; 1 Aus-/ Einschalten „Stoppe bei Erreichen der 
Verfahrlimits“ 

KEEP_IN_TRAVEL_RAN
GE 

0; 1 Aus-/ Einschalten „halte Robot Joints in 
Verfahrbereichen“ 
Annahme: 
1. Achse 6 (rotZ) hat Limits swe=[-180,+180]; 
2. KEEP_IN_TRAVEL_RANGE auf ON (1) 
 
Wenn die Achse auf z.B. “+181°” dreht, wird 
der Achswert automatisch auf “-179°” 
gesetzt, damit die Mathematik im 
Hintergrund die Winkel in den Limits 
berechnet.  
Um die Mathematik im Hintergrund den 
kürzesten Winkel zum vorherigen 
Achswinkel berechnen zu lassen, muss die 
Variable auf OFF (0) gesetzt werden.  
 
Der Zustand (OFF) ist Default, weil in der 
Praxis häufiger angewendet. 

STOP_SPEED 0; 1 Aus-/ Einschalten „Stoppe bei 
Überschreitung der Geschwindigkeit“ 

STOP_ACCEL 0; 1 Aus-/ Einschalten „Stoppe bei 
Überschreitung der Beschleunigung“ 

STOP_COLLISION 0; 1 Aus-/ Einschalten „Stoppe bei Kollision“ 
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Environment Variablen 
 

Kommando und Syntax Gültige Werte Beschreibung 

USE_VBO 0; 1 Aus-/ Einschalten Vertex Buffer Objects  
(falls von Grafikkarte unterstützt)  
 
Anmerkung:  
Bei Nutzung von VBO wird die Geometrie in 
die Grafikkarte geladen. Um die Rendering-
Performance zu steigern, sollte die 
Geometrie gemerged sein. 
VBO erfordert mindestens die OpenGL 
Version 1.5 
(Prüfen der vorliegenden Version: 
Menü -> Aux -> Show current Settings) 
 
Bei unerwünschten Effekten (auch mit 
OpenGL Version 1.5) setzen Sie USE_VBO 
auf OFF. 

DISABLE_CROBOT_BBO
X 

0; 1 Aus-/ Einschalten „Visualisierung der bBox 
für den aktuellen Roboter“ 

DISABLE_3D_CAD_BBO
X 

0; 1 Aus-/ Einschalten „Visualisierung der bBox 
für das aktuelle 3D CAD -Objekt 

DISABLE_TOOLBAR 00000000 …. 11111111 Ein-/ Ausschalten „Toolbar“ 
 
Bit 0: alle Toolbars ein 
Bit 1: Load,Save Toolbar 
Bit 2: Render Toolbar 
Bit 3: Run Toolbar 
Bit 4: OnOff Toolbar 
Bit 5: 3DCad Toolbar 
Bit 6: Move Toolbar 
Bit 7: MouseMove Toolbar 
 
Beispiel 00010000 --> Bit 3 schaltet Run 
Toolbar aus 
Beispiel 01111110 --> schaltet nur 
MouseMove Toolbar ein 
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Environment Variablen 
 

Kommando und Syntax Gültige Werte Beschreibung 

COLL_BODY_ROBOT 0; 1 Aus-/ Einschalten Kollisionsprüfung alle 
Bodies gegen alle Roboter 

COLL_BODY_TOOL 0; 1 Aus-/ Einschalten Kollisionsprüfung alle 
Bodies gegen alle Tools 

COLL_ROBOT_TOOL 0; 1 Aus-/ Einschalten Kollisionsprüfung alle 
Roboter gegen ihre Tools  

COLL_GRAB_BODY_BODY 0; 1 Aus-/ Einschalten Prüfung alle 
gegriffenen Bodies gegen nicht 
gegriffenen  Bodies 

COLL_GRAB_BODY_ROBOT 0; 1 Aus-/ Einschalten Kollisionsprüfung alle 
gegriffenen Bodies gegen alle Roboter 

COLL_ROBOT_ROBOT 0; 1 Aus-/ Einschalten Kollisionsprüfung 
Roboter gegen sich selbst 

COLL_BODY_BODY 0; 1 Aus-/ Einschalten Kollisionsprüfung 
Bodies gegen sich selbst 

COLL_LINE_ENABLE 0; 1 Aus-/ Einschalten der Kollisionslinie 

COLL_DETECCODE 0; 1; 2 Auswahl des Collision Detection Codes 
0 - Zellen ohne Kollision laden 
1 - OpCode (nur x86) 
2 - PQP „A Proximity Query PackageA 

TEXT SIZE 1 2 Ändert die Schriftgröße für allgemeine 
Texte und Tags (2. Parameter) 
1 - TYPE 10 SEMIBOLD ARIAL 
bis 
8 - TYPE 24 SEMIBOLD ARIAL 

WORLD_COORSYS 0; 1 Aus-/ Einschalten des 
Weltkoordinatensystems 

TAG_COORSYS 0; 1 Aus-/ Einschalten des Pfade und Tags 

ROBOT_COORSYS 0; 1 Aus-/ Einschalten der 
Roboter-Achs-Koordinatensystems 

ROBOT_BASE_COORSYS 0; 1 Aus-/ Einschalten des  
Roboter-Basis-Koordinatensystems 

BODY_COORSYS 0; 1 Aus-/ Einschalten des 
Bodykoordinatensystems 
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Environment Variablen 
 

Kommando und Syntax Gültige Werte Beschreibung 

ROBOT_TCP_COORSYS 0; 1 Aus-/ Einschalten des  
Roboter-TCP-Koordinatensystems 

IPO_COORSYS 0; 1 Aus-/ Einschalten des temporären IPO 
Koordinatensystems 

CRUISE_ROT_FLAGS LMB; MMB; RMB, SHIFT, CNTRL Taste für Rotation der Welt 

CRUISE_ZOOM_FLAGS LMB; MMB; RMB, SHIFT, CNTRL Taste für das Zoomen 

CRUISE_ZOOM2MB_FLAGS LMB; MMB; RMB, SHIFT, CNTRL Falls „2 Mouse Button“ im Aux menu -> 
„Mouse Mode“ deaktiviert ist; alternative 
Möglichkeit zum Zoomen 

CRUISE_PAN_FLAGS LMB; MMB; RMB, SHIFT, CNTRL Verschieben der Arbeitswelt 

CRUISE_ROT_FLAGS_2 LMB; MMB; RMB, SHIFT, CNTRL, UNDEF Alternative: Taste für Rotation der Welt 

CRUISE_ZOOM_FLAGS_2 LMB; MMB; RMB, SHIFT, CNTRL, UNDEF Alternative: Taste für Zoomen 

CRUISE_PAN_FLAGS_2 LMB; MMB; RMB, SHIFT, CNTRL, UNDEF Alternative: Taste für Verschieben 

CRUISE_COMMON_FLAGS DEFAULT Filtert Cruise Mouse Button 

DLG_TRANSPARENCY 0x1001  alpha; 
0x1002  alpha; 
0x1004  alpha; 
0x1008  alpha; 
0x1010  alpha; 

Legt den Voreinstellungswert für die 
Transparenz der Dialoge fest. 
OFF: 0x1001 
Low: 0x1002 
Medium; 0x1004 
High: 0x1008 
User: 0x1010 

alpha = 100-255 
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EASY-ROB™ Bedienungshinweise 

System Dateien 

Konfigurationsdatei: config.dat 

 

 
EASY-ROBTM benötigt eine Konfigurationsdatei für den Start. Die Konfigurationsdatei "config.dat" wird 
automatisch bei jedem Start von EASY-ROBTM geladen und enthält Informationen zu: 
 

- dem Pfad / Speicherort der Lizenzdatei "license.dat" 
- dem Pfad zu den „temporären Dateien“ 
- dem Pfad zu den „Benutzerdateien“ 
- Bibliothekspfade und DLL-Namen, bei Nutzung der API-User DLL Option 
- Bevorzugten Editor 

 
 
Mit einer “eigenen” Konfigurations-Datei kann jeder Bediener das EASY-ROBTM mit den „eigenen“ 
bevorzugten Einstellungen starten und nutzen. 
 
 
Änderungen in der Datei können durch manuelles Editieren vorgenommen werden. 
 
Um die Datei zu editieren kann der Bediener  
 den Tastenkombination verwenden : “Alt+Shift+C” 
 
 oder das Menü nutzen:    File menu ->Edit-> EASY-ROB System files->  „Config file“ 
  
 
Anmerkung: 
Ein Ausrufezeichen ( ! ) am Anfang einer Zeile in der Systemdatei steht für eine Kommentarzeile. Sie 
können jeglichen Kommentar in diese Zeile schreiben – sie wird bei der Ausführung ignoriert. 
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Config File 
 

Kommando und Syntax Gültige Werte Beschreibung 

LICENSE= ..\ 
 
oder komplette Pfadangabe 
 c:\......\........\ 

Pfad für das License-File 
Default ist der Zielordner der Installation 
”c:\Programme\EASY_ROB\” 
 
(siehe auch Details LICENSE unten) 

TMPDIR= Absolute und relative Pfadangaben 
sind erlaubt 

Beinhaltete Dateien: 

- moni_msg.txt  

- HardwareNumber.dat  

Beispiel für Pfadangabe: 

TMPDIR=%USERPROFILE%\EASY-ROB\tmp 

Default ist der Zielordner der Installation 

USRDIR= Absolute und relative Pfadangaben 
sind erlaubt 

Beinhaltete Dateien: 

- easy-rob.pth (neue Datei) 

- easy-rob.env 

- easy-rob-localizationx64.ini 

- er_LoadFromLibPb.ini  

- er_LoadFromLibPb_prefered.ini  

Beispiel für Pfadangabe: 

USRDIR=%USERPROFILE%\EASY-ROB 

Default ist der Zielordner der Installation 

LIBRARY_PATH= Absolute und relative Pfadangaben 
sind erlaubt 

Pfad für den Ort der UserDLL’s 
Beispiel: 
.\    aktueller Ordner 
..\    ein Ordner über aktuellem 
    Ordner 
“c:\home\my_er”  absoluter Pfad 
 
Default: LIBRARY_PATH= .\ 
 
(siehe auch Details API User DLL unten) 

USER_DLL= “<name> <start option> <comment 
string>” 

Name der UserDLL 
 
(siehe auch API User DLL unten ) 

EDIT= Jeder ausführbare Editor 
z.B.. notepad, notepad++, ... 
 

Variable zum Setzen des bevorzugten Editors. 
Beispiel: 
EDIT=notepad 
oder 
EDIT= C:\program files\vim\gvim 

Default: EDIT= notepad 
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Config File 
 

Kommando und Syntax Gültige Werte Beschreibung 

HELPFLN= .\help.erh relatives Verzeichnis des help files 

ER_KIN_DLL= er_kinx.dll API-KIN, Benutzerdefinierter Name für 
vorwärts und inverse Kinematik 
x = „“ bei EASY-ROB™ x86 Version 
x = „x64“ bei EASY-ROB™ x64 Version 
x = „dll“ bei EASY-ROB™ DLL Version 
x = „dllx64“ bei EASY-ROB™ DLL x64 

ER_IPO_DLL= er_ipox64.dll API-IPO, Benutzerdefinierter Name für 
Bewegungsplanung und Ausführung 

ER_DYN_DLL= er_dynx64.dll API-DYN, Benutzerdefinierter Name für 
Dynamik und Steuerung 

ER_POST_DLL= er_postx64.dll API-PostProcess, Benutzerdefinierter Name 
für PostProzessor 

ER_SENSOR_DLL= er_sensorx64.dll Benutzerdefinierter Name für Sensor-
Integration 

USR_OWNERKEY_DIR= Absolute und relative Pfadangaben 
sind erlaubt 

Verzeichnis der OwnerKey Datei 

USR_OWNERKEY_FLN= Absolute und relative Pfadangaben 
sind erlaubt 

Name der OwnerKey Datei 
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Config File 
 

 

Details zur Variable “LICENSE” in Config file  
 
Jedes EASY-ROBTM Produkt (Ausnahmen sind DEMO- und VIEWER-Version) benötigt eine Lizenz zum 
Starten. 
Diese Lizenz ist eine Textdatei mit dem Namen "license.dat" und wird beim Kauf ausgehändigt. 
Während der Standardinstallation wird die Lizenzdatei automatisch in das Standard-Zielverzeichnis kopiert. 
 
 
Beim Start von EASY-ROBTM  sucht das Programm zunächst in der Config Datei nach dem Pfadangabe der 
Lizenzdatei. Danach prüft EASY-ROBTM in dem gegebenen Pfad die Lizenz auf Gültigkeit. 
 
 
Anmerkung:  
 
Bei der Standardinstallation wir die Lizenzdatei in das Standard-Zielverzeichnis kopiert: 
 
 C:\ Program Files \ EASY-ROB \ 
 
 wobei die EASY-ROBTM Software in folgendem Pfad installiert wird: 
 C:\ Program Files \ EASY-ROB \ EASY-ROB x64 \ 
 
 
 
Aus diesem Grund ist der Defaultwert für die Variable: 
 
 LICENSE= ..\ 
 
 
Achtung: 
Wenn Sie nicht die Standardinstallation durchführen oder wenn Sie nach der Installation die Pfade manuell 
verändern, müssen Sie die Variable für die Lizenzdatei in der Konfigurations-Datei überprüfen und ggf. 
anpassen. 
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Config File 
 

 

Details zu den Variablen “LIBRARY_PATH” und “USER_DLL“ im Config file  
 
 
Mit der Option API-UserDLL kann EASY-ROB™ individuell per API an die Bedürfnisse angepasst werden. 
So können eigene Bediendialoge entwickelt und bei jedem Start von EASY-ROB™ automatisch aufgerufen 
werden. 
 
Die Information für EASY-ROB™, welche UserDLL geladen werden muss, befindet sich auch im Config file. 
 
 
Die Variable für die Pfadangabe heißt “LIBRARY_PATH” und gibt das Verzeichnis an, in dem die UserDLL 
abgelegt ist. 
  
Beispiel: LIBRARY_PATH= .\ 
 
 
Absolute and relative Pfadangaben sind erlaubt: 
 
  .\  aktueller Ordner 
  ..\  ein Ordner über aktuellem Ordner 
 c:\home\my_er”  absoluter Pfad 
 “\\ws01\my_er”  absoluter Pfad 
 
 
 
Die Variable für den Namen der UserDLL ist “USER_DLL” und hat 3 Parameter. 
 

1. der DLL Name- z.B. "er_vad_exp01.dll" 
2. ein Ziffer für die Startoption  

”1” startet den Dialog sofort beim Start von EASY-ROB™  
"0" erfordert den manuellen Start des UserDLL-Dialogs über View Menu-> API UserDLL Dialoge 

3. ein Benutzerdefinierter String als Kommentar 
 
 
Beispiel: USER_DLL= er_vad_exp01.dll 1 Api UserDll Expl_01 
  USER_DLL= er_vad_exp02.dll 1 Api UserDll Expl_02 
 
 
 
 
Anmerkung: 
Falls Sie die API-UserDLL’s nicht im Standardverzeichnis ablegen, müssen Sie sicherstellen, dass alle 
anderen DLL’s (die von der UserDLL benötigt werden) auch gefunden werden können.  
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EASY-ROB™ Bedienungshinweise 

System Files 

Lizenzdatei: license.dat 

 

 
Die Lizenzdatei „license.dat“ enthält einen einmaligen Lizenzschlüssel für das entsprechende Produkt mit 
Ablaufdatum. 
 
Zum Ansehen der Datei öffnen Sie diese über das Menü: 
 

File -> Edit-> EASY-ROB System files->  „License file“ 
 
 oder mit der Tastenkombination : “Alt+Shift+L” 
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EASY-ROB™ Bedienungshinweise 

System Files 

Monitoring Message Datei: moni_msg.txt 

 

 
Die Datei „moni_msg.txt“ protokolliert die allgemeine Systeminformation während einer EASY-ROB™ 
Session. 
 
Dies sind Informationen wie z.B.:  

- das „working directory“ 
- Datum und Zeit 
- Lizenzdatei  
- alle freigeschalteten bzw. gesperrten Optionen 
- Verzeichnis der Environment Datei und Config Datei 

 
 
Diese Datei kann dem EASY-ROB-Support-Team auch beim Support helfen. 
Im Fall eines Problems können Sie die Monitoring Message Datei für die Analyse zusammen mit der 
Supportanfrage an EASY-ROB schicken. 
 
 
 
 
Um die Datei anzusehen öffnen Sie diese über das Menü: 
 

File -> Edit-> EASY-ROB System files->  „moni_msg file“ 
 
 oder mit der Tastenkombination : “Alt+Shift+M” 
 
 
 
Tipp: 
Im Fall von extrem zeitaufwendigen Informationsausgaben wie z.B. beim Laden einer Arbeitszelle mit 
extrem vielen Tagpunkten, kann man die Environment Variable MONI_MSG_OUTPUT in der Datei “easy-
rob.env” ausschalten [0]. 
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EASY-ROB™ Bedienungshinweise 

System Files 

Bevorzugte Pfade Datei: er_LoadFromLibPb_prefered.ini 

 

 

Bevorzugte Pfade 
 
Zusätzlich zur automatisch erzeugten Pfadhistorie im Device Manager werden im selben Pulldown-Menü 
auch so genannte „bevorzugte Pfade“ zur Verfügung gestellt. Die „bevorzugten Pfade“ werden vom 
Bediener manuell angelegt, in dem er in der Datei „er_LoadFromLibPb_prefered.ini“ seine 

bevorzugten Pfade angibt. 
 
Diese Datei wird einmalig vom System angelegt, falls sie nicht existiert. Im Unterschied zu der automatisch 
erzeugten Pfadhistorie, bleiben die „bevorzugten Pfade“ unverändert und ermöglichen dem Bediener so 
einen schnellen Zugriff auf seine 12 wichtigsten Pfade. 
 
Die Pfade müssen wie in dem untenstehenden Beispiel komplett angegeben werden. 
Zeilen, die mit einem Ausrufezeichen beginnen werden als Kommentar gewertet. 
 
 
Beispiel: 
 

 ! 

 ! This file contains all your prefered/favorite paths 

 ! 

 ! All lines starting with "!" will be ignored 

 ! 

 ! Maximum numbers of paths is 12 

 !------------------------------------------------------ 

 ! 

 C:\Program Files\EASY-ROB\ApplicationLib 

 C:\Program Files\EASY-ROB\DeviceLib 

 C:\Program Files\EASY-ROB\RobotLib 

 C:\Program Files\EASY-ROB\Tutorial\Proj_example_erpl 

 ! 

 ! 

 
 
Um die Datei zu editieren, öffnen Sie diese über das Menü: 
 

File -> Edit-> EASY-ROB System files->  „er_LoadFromLibPb_prefered.ini“ 
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EASY-ROB™ Bedienungshinweise 

System Files 

Working Pathes File: easy-rob.pth 

 

 

Details zu den Variablen “WORKDIR“ und „IGPDIR “ im Working Pathes File 
 
Damit Anwender Ihre eigenen Arbeits- und Geometrieordner festlegen können, welche ggfs. von den 
Benutzerordnern abweichen, wurden die Pfade für diese Ordner aus der config.dat herausgetrennt und 
werden zukünftig in der neuen Datei “easy-rob.pth“ verwaltet. 
 
Hier können Pfade für die Arbeits- und Geometrieverzeichnisse mit 
 

- WORKDIR=  
- IGPDIR=  

 
festgesetzt werden. 
 
 
Um eine gute Übersicht zu behalten wird empfohlen alle Projekte in separaten Bibliotheken zu speichern 
und in diesen wiederum eine bestimmte Ordnung einzuhalten. 
 
 
Die Datenhaltungs-Philosophie in EASY-ROBTM  basiert auf 2 Verzeichnissen.  
Dem „working directory“/ „Arbeitsverzeichnis“ (WORKDIR) und dem „3D CAD Verzeichnis“ (IGPDIR). 
 
Das „working directory“ (WORKDIR) enthält: 

- Zelldateien (*.cel) 
- Roboterdateien (*.rob) 
- Programmdateien (*.prg) 
- Views (*.vie) 
- Text (*.txt), 
- Bitmaps (*.bmp) 
- Daten (*.dat) 
- JPEG (*.jpg) 

 
Das 3D CAD Verzeichnis (IGPDIR) enthält alle 3D Geometrien wie: 

- *.igp 
- *.stl 
- *.wrl 
- *.stp 
- *.3ds 
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Working Pathes File  
 

 

Details zu den Variablen “WORKDIR“ und „IGPDIR “ in Working Pathes File 
 
Damit EASY-ROBTM  die entsprechenden Parts/Teile einer Arbeitszelle finden kann, müssen die 
WORKDIR-Pfade und IGPDIR-Pfade in der Working Pathes File deklariert werden. 
 
 Beispiel: 
 WORKDIR= ..\ApplicationLib\ArcWelding 
 IGPDIR= ..\ApplicationLib\ArcWelding\igp 
 
Mittels dieser Pfadangaben „weiß“ das System wo die entsprechenden Teile, Programme und Roboter für 
eine bestimmte Zelle zu finden sind. 
 
Note: 
Absolute und relative Pfadangaben sind erlaubt: 
 

.\   aktueller Ordner 

..\   ein Ordner über aktuellem Ordner 
“c:\home\my_er” absoluter Pfad 
\\ws01\my_er  absoluter Pfad 

 
 
Wichtiger Hinweis: 
Eine EASY-ROBTM  Zelle- bzw. Roboterdatei (.cel/.rob) enthält lediglich den Dateinamen (plus Endung) von 
einer 3D CAD Geometrie, aber nicht den Inhalt! 
Um eine angegebene Datei auf der Festplatte, dem Memorystick oder im Netzwerk zu finden, sucht EASY-
ROBTM  in allen definierten IGPDIR-Pfaden. Standardmäßig sucht EASY-ROBTM  auch im Unterordner mit 
dem Namen „.\igp“ der geladenen Zell- bzw. Rob-datei. 

 

Kommando und Syntax Gültige Werte Beschreibung 

WORKDIR= Absolute und relative Pfadangaben 
sind erlaubt 

Pfad für das „Working directory“ 
Beispiel: 
.\    aktueller Ordner 
..\    ein Ordner über 
aktuellem 
    Ordner 
“c:\home\my_er”  absoluter Pfad 
“\\ws01\my_er”   absoluter Pfad 
 
(siehe auch Details WORKDIR unten) 

IGPDIR= Absolute und relative Pfadangaben 
sind erlaubt 

Pfad für die „3D CAD Geometrie“ 
Beispiel: 
.\    aktueller Ordner 
..\    ein Ordner über 
aktuellem 
    Ordner 
“c:\home\my_er”  absoluter Pfad 
“\\ws01\my_er”   absoluter Pfad 
 
(siehe auch Details IGPDIR unten) 
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EASY-ROB™ Bedienungshinweise 

System Files 

Lokalisationsdatei: easy-rob-localizationx64.ini 

 

 

Details zu den Variablen “en-US“, „de-DE“ und „zh-Hans“ 
 
Die Lokalisation erfolgt unter dem Menüpunkt  
„Datei → Edit → EASY-ROB Systemfiles → Localization Datei“  
und wird durch ausklammern der nichtgewünschten Sprachen mit einem „!“ vor den Zeilen: 
 

- en-US für Englisch  
- de-DE für Deutsch  
- zh-Hans für Chinesisch (traditionell) 

 
erreicht. Auf der nachfolgenden Seite wurde in der Lokalisationsdatei die deutsche Sprache aktiviert.  
 

! EASY-ROB 3D Robot Simulation Tool 

! 

! EXE - Simulation Version x64 

! 

! Localization file 

! 

! "easy-rob-localizationx64.ini" 

! 

! Make sure that the localization Dlls exist 

! 

! Allowed language keys are 

! 

! en-US ==> EasyRobwx64ENU.dll (english) 

! de-DE ==> EasyRobwx64DEU.dll (german) 

! zh-Hans ==> EasyRobwx64CHS.dll (chinese) 

! 

! Note: '!' or ';' comment a line 

! 

!en-US 

de-DE 

!zh-Hans 

! 

 

EASY-ROB™ sucht dabei nach folgenden Lokalisation-DLLs im Installationsverzeichnis: 
 

- EasyRobwx64CHS.dll 
- EasyRobwx64DEU.dll 
- EasyRobwx64ENU.dll 

 
Sollten die Lokalisation-DLLs nicht vorhanden sein, startet EASY-ROB™ mit Englischem GUI, was die 
Standardeinstellung ist. 
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EASY-ROB™ Bedienungshinweise 

Erste Schritte mit EASY-ROB™ 

Aufbau einer einfachen Arbeitszelle mit Roboter und Werkzeug 
 
 
Unsere einfache Arbeitszelle soll vorerst aus einem Roboter mit einem Werkzeug bestehen. 
 

 
 

Laden eines Roboters 
 
Nach dem Start von EASY-ROB™ 
wird über das Menü File / Load 
Robot file aus dem Verzeichnis 
„.\Easy-Rob\TrainLib“ der Roboter 
robot.rob geladen. 
 
Der Roboter ist nun im 
Hauptfenster von EASY-ROB™ zu 
sehen. Es handelt sich um einen 
Knickarmroboter mit sechs 
Achsen, also um einen typischen  
Industrieroboter. 
 
 

Laden eines Werkzeugs 
 
Analog wird über Menü File / Load 
Tool file das Werkzeug tool.tol 
geladen. 
 
 

Sichern Sie nun den Zwischenstand in dem Sie im Menü File / Save Robot file unter dem Dateinamen 
robot_tool.rob speichern. (Hinweis: Die Endung *.rob wird automatische hinzugefügt) 
 
Hinweis: Die Dateien mit der Endung .rob können sowohl Informationen über den Roboter als auch über 
das verwendete Werkzeug enthalten. 
 
Tipp: Wie Sie es aus anderen Anwendungen gewohnt sind, können Sie Dateien zum Laden auch direkt aus 
dem Windows® -Explorer in das EASY-ROB™-Hauptfenster ziehen (Drag’n‘Drop). 
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Erste Schritte mit EASY-ROB™ 
 

Navigieren in der Arbeitszelle und Bewegen des Roboters  
 
Mittels der rechts dargestellten Symbole, wird in der Arbeitszelle navigiert bzw. der 
Roboter bewegt. Das erste Symbol ist der Navigationscursor mittels dem eine 
Bewegung in der Welt möglich ist. Das zweite bzw. dritte Symbol erlaubt die 
Bewegung des Roboters in Werkzeug- bzw. in Weltkoordinaten, wobei mit dem 
letzten Symbol zwischen translatorischer und rotatorischer Bewegung umgeschaltet 
wird. Mit dem Symbol Robot Joints erfolgt die Bewegung des Roboters in 
Achskoordinaten. 
 
Hinweis: Machen Sie sich mit den einzelnen Funktionen vertraut, in dem Sie diese 
auswählen und dann im Hauptfenster von EASY-ROB™ mit der Maus und 
gedrückten Maustasten bewegen. Nutzer mit einer 2-Tasten-Maus, müssen dazu im 
Menü Aux / Mouse Mode die Option 2 Mouse Buttons aktivieren und die 
Einstellungen mit File / Save / Environment file speichern.  
 
Tipp: Mit einem Doppelklick auf die einzelnen Symbole werden erweiterte Funktionen 
zugänglich. 
 
 

                    
 
 
 

Erweiterung der Arbeitszelle durch Hinzufügen eines Werkstücks 
 

 
 
 
 

Auswahl der CAD-Gruppe 
 
3D-CAD-Daten werden in EASY-ROB™ in drei 
Gruppen gegliedert.  
 
Die Robot Group beinhaltet alle Daten, die den 
Roboter betreffen (z.B. die Roboterbasis oder 
den Roboterflansch).  
 
In der Tool Group finden sich alle Daten wieder, 
die dem Werkzeug zuzuordnen sind.  
 
Werkstücke und alle weiteren Geometrien der 
Arbeitszelle sind in der Body Group 
eingeordnet, welche wir mit Hilfe des Menüs 
3D-CAD / Select Group / Body Group 
auswählen. 
 
 

Hinweis: EASY-ROB™ ist kein 3D-CAD-System, sondern ein Roboter-Simulationssystem. Nur einfache 
Geometrien wie beispielsweise Quader, Zylinder, Kegel und Kugeln können in EASY-ROB™ erzeugt 
werden. Daher muss die Modellierung komplexerer Geometrien generell in 3D-CAD-Systemen erfolgen. Die 
Geometrien können dann in EASY-ROB™ importiert werden. Um eine effiziente Simulation zu ermöglichen, 
sollte der Detaillierungsgrad für die Robotersimulation reduziert werden. Es ist aus Gründen der 
Performance verständlicherweise nicht sinnvoll hier „jede Schraube“ darstellen zu wollen. 
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Erste Schritte mit EASY-ROB™ 
 

Hinzufügen des Werkstücks 
 
Durch Auswahl des Menüpunkts 3D-CAD / 
Create/Import new 3D CAD Body / CUBE wird in der 
Arbeitszelle ein Quader erzeugt. 
 
Die räumliche Lage des Körpers wird später 
festgelegt. 
 

 
 
 

Setzen Sie nun die Länge des Körpers (X) auf 200 
mm, die Breite (Y) auf 300 mm und die Höhe auf 550 
mm. 
 

 
 
 

 
 
Positionieren des Werkstücks 
 
Um das Werkstück zu positionieren, wählen  
Sie aus dem 3D-CAD Menü den Untereintrag  
Enter Positions / World Position. 
 
Der EASY-ROB™-Frame-Dialog bietet unter 
anderem die Möglichkeit die räumliche Lage eines 
Körpers in 6 Freiheitsgraden zu definieren. 
 
Setzen Sie den Körper wie abgebildet auf die 
Position X=450 mm, Y=300 mm und Z=0 mm.  
 

 
 

 Geben Sie dem Körper anschließend den 
 Namen BOX. 
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Erste Schritte mit EASY-ROB™ 
 
 Ändern der Farbe des Werkstücks 

 
Um die Farbe des Körpers zu ändern, wählen Sie den Menüpunkt 3D-CAD / Color. 
 

 
 

 

Speichern der aktuellen Positionen 
 
Speichern Sie die aktuellen Positionen aller 
sich in der Arbeitszelle befindenden Körper 
(Roboter und Werkstück) als Startpositionen, 
in dem Sie im Menü Simulation / Save Start 
Condition / Save all Robots Positions and 
Joints as Start Condition  auswählen. 
 
Mit den restlichen Funktionen in diesem Menu 
können auch nur bestimmte Positionen 
einzelner Bauteile gespeichert werden. 
 
Tipp: Zum Zurücksetzen der Körper in diese 
Position verwenden Sie das Menü Simulaion/ 
Reset Start Condition/ Reset all Positions and 
Joints as Start Condition   
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Erste Schritte mit EASY-ROB™ 
 

Speichern der Arbeitszelle 
 
Speichern Sie den aktuellen 
Bearbeitungsstand als Arbeitszelle unter 
dem Dateinamen „box.cel“ in dem Sie im 
Menü auf File / Save Cellfile klicken. 
 
 
 
 
Wenn man die folgende Abfrage „Reset 
all Positions and Joints to Start 
condition“ mit “Ja” bestätigt, wird alles 
auf die Startposition zurückgesetzt. (Das 
sind die Positionen, die wir im vorigen 
Schritt gespeichert haben) 
 
Achtung:  
Wenn man die Positionen nicht 
gespeichert hat und dennoch mit „Ja“ 
bestätigt, kann dies zu unerwünschten 
Positionsänderungen führen, die nicht 
mit einem Knopfdruck rückgängig 
gemacht werden können. 
 
Wenn man die Abfrage mit „Nein“ 
bestätigt, hat man nach der Eingabe des 
Namens der zu speichernden Zelle noch 
die Möglichkeit die derzeitigen 
Positionen als Startwerte zu speichern 
 
 
 
Hinweis: EASY-ROB™-Arbeitszellen 
(Dateien mit der Endung .cel) enthalten 
alle Informationen über Roboter, 
Werkzeug und Werkstücke sowie 
Verweise auf etwaige 
Roboterprogramme. 
 
 
Tipp: Arbeitszellen können ebenfalls 
durch die Auswahl des 
Diskettensymbols aus  
der Symbolleiste  
gespeichert werden. 
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Erste Schritte mit EASY-ROB™ 
 

Setzen von Arbeitspunkten (Tag-Punkte) 
 

 

Tag-Punkte (Teach-Punkte) beschreiben unter anderem die 
räumliche Lage, also Position und Orientierung, von 
Arbeitspunkten, welche vom Roboter anzufahren sind. 
 
Hinweis: Das Tag-Fenster wird durch einfachen  
Mausklick auf das Symbol SEL TAG aufgerufen. 
 

Aufgabenstellung: 
 
An jede der vier oberen Ecken des Quaders soll jeweils ein Tag-
Punkt erzeugt werden (Nr. 2 bis 5). Zusätzlich soll ein Tag-Punkt 
(Nr. 1) als Anfahrpunkt definiert werden. 
 

 
 

 
 

 
 
Vorgehensweise zur Erzeugung der Tag-Punkte 
 

 

Klicken Sie einmal auf den Knopf New TCP Tag. Dadurch wird ein 
Tag-Punkt an der Werkzeugspitze (Tool Center Point: TCP) 
erzeugt. Der Tag-Punkt wird in der Tag-Auswahlliste erscheinen.  
 
Setzen Sie nun die Position des Tag-Punktes T_1 auf X=450 mm, 
Y=300 mm, Z=700 mm und die Orientierung des Tag-Punktes auf 
Rx=0 Grad, Ry=180 Grad und Rz=0 Grad.  

 
 

Aktivieren Sie nun das Kontrollkästchen TCP Jog unten im TagWindow, der Roboter wird nun zum ersten 
Tag-Punkt springen, d.h. das TCP-Koordinatensystem und das Tag-Koordinatensystem werden in Deckung 
gebracht. 
 
Klicken Sie nun nochmals auf New TCP Tag um den Tag-Punkt T_2 zu erzeugen. Dieser liegt 
Deckungsgleich mit T_1. Verschieben Sie den Tag-Punkt T_2 auf die Höhe von Z=550 mm. Tag-Punkt T_2 
liegt nun auf der ersten Ecke des Quaders.  
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Erste Schritte mit EASY-ROB™ 
 
Erzeugen Sie nun den Tag-Punkt T_3 und setzen die Y-Koordinate auf 600 mm. Danach erzeugen Sie den 
T_4 mit der X-Koordinate 650 mm. Abschließend wird der Tag-Punkt T_5 erzeugt, welcher auf Y=300 mm 
liegt 
 
Zur Kontrolle enthält nachfolgende Tabelle nochmals die räumliche Lage aller fünf Tag-Punkte: 

 

Tag X [mm] Y [mm] Z [mm] Rx [deg] Ry [deg] Rz [deg] 

T_1 450 300 700 0 180 0 

T_2 450 300 550 0 180 0 

T_3 450 600 550 0 180 0 

T_4 650 600 550 0 180 0 

T_5 650 300 550 0 180 0 

 
Tipp: Zur einfacheren Positionierung können Sie die 
Funktionalität des EASY-ROB™-Formel-Parser nutzen. Falls ein 
Tag-Punkt, der in der Höhe von Z=700 mm liegt, beispielsweise 
auf die Höhe 550 mm verschoben werden soll, geben Sie 
einfach im Z-Feld 700-150 ein. 
 
Stimmt die Lage Ihrer Tag-Punkte mit denen in der Tabelle 
überein, so fahren Sie den Roboter in die Home-Position und 
speichern Sie den momentanen Arbeitsstand unter dem 
Dateinamen box_tags.cel als Arbeitszelle. 
 
 

 

 
 
 

 
 

Hinweis: Die EASY-ROB™-Arbeitszelldateien beinhalten auch die erzeugten 
Tag-Punkte. Darüber hinaus wird beim Speichern die momentane Stellung des 
Roboters als Ausgangsstellung definiert. 
 
Tipp: Um die Tag-Punkte entsprechend der Listenreihenfolge automatisch 
anzufahren, wählen Sie den ersten Tag-Punkt und Klicken Sie auf Move Along. 
Mit welcher Bewegungsart die einzelnen Tag-Punkte angefahren werden sollen, 
definieren Sie mit dem Knopf Motion type im TagWindow. 
 

 
 
Tipp: Die Reihenfolge der Tag-Punkte kann mit der Up und Down Buttons 
verändert werden. 
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Erste Schritte mit EASY-ROB™ 
 

Erzeugen eines PTP-Roboterprogramms in EASY-ROB™ 
 
Öffnen Sie zunächst das TeachWindow  
durch Mausklick auf das entsprechende  
Symbol. 
 
Erzeugen Sie ein neues Programm durch Klick auf 
den Knopf New. Dann speichern Sie das Programm 
durch Klick auf Save as im TeachWindow unter dem 
Namen prg_ptp. Sichern Sie die Zelle unter dem 
Namen box_prg_ptp.cel. 
 
Hinweis: Der Name des EASY-ROB™-Programms 
wird in der Arbeitszelldatei gespeichert. Das 
Programm wird dann beim nächsten Laden der Zelle 
automatisch aktiviert. 
 

Umbenennen des Unterprogramms 
 
Die PTP-Bewegungsvorgaben (Point-to-Point) sollen 
in einer Funktion mit dem Namen sub_ptp abgelegt 
werden. Holen Sie durch einen Doppelklick die 
Programmzeile call my_fct_name() in die Edit-Zeile 
des TechWindows und ändern Sie diese in call 
sub_ptp(). Durch einen Druck auf die Return-Taste 
wird die editierte Zeile in das Roboterprogramm 
übernommen. Ändern Sie nun den Namen der 
Funktion, d.h. ändern Sie die Programmzeile 
fct my_fct_name() in fct sub_ptp(). 
 
 

 
 

 
 

Hinweis: Programme können in EASY-ROB™ sehr komfortabel durch Mausklicks 
erzeugt werden. Die einzelnen Programmbefehle lassen sich in die Gruppen 
Motion, Cntrl und ERC einteilen. Verschaffen Sie sich eine Übersicht durch Klick 
auf die entsprechenden Knöpfe im TeachWindow (> Motion,  > Cntrl,  > ERC). 
 

Einfügen der Bewegungsbefehle für PTP 
 
Befehle werden immer vor der aktuellen Zeile eingefügt. Wählen Sie daher die 
letzte Programmzeile endfct aus. Zuerst soll der Roboter in die Home-Position 
fahren. Fügen Sie den Befehl Home 1 durch klicken auf den Home-Knopf im Teach 
Window zu dem Unterprogramm hinzu. 
 
Öffnen Sie nun das TagWindow und wählen Sie den ersten Tag-Punkt T_1. 
Drücken Sie nun den Knopf PTP cTag im TeachWindow (cTag steht für current 
Tag, d.h. für den momentan ausgewählten Tag-Punkt). 
 
Verfahren Sie ebenso mit den weiteren Tag–Punkten T_2 bis T_5. Fügen Sie 
abschließend noch Verfahranweisungen zu T_2, zum Anfahrpunkt T_1 und zur 
Home-Position hinzu. 

Speichern Sie das Programm durch Klick auf den Save-Knopf im TeachWindow. 
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Erste Schritte mit EASY-ROB™ 
 

Ausführen des Programms 
 
Das Programm wird durch Klick auf den Run-Knopf gestartet. Die 
Simulationsgeschwindigkeit kann mittels des Decrease Stepsize- (Ctrl + Shift + -) und 
des Increase Stepsize-Knopfs (Ctrl +) angepasst werden. 
 
Tipp: Um das Programm unendlich oft abzuspielen, drücken Sie auf den Repeat-Knopf. 
 

 
 

 

 

Hinweis: Den TCP-Trace können Sie sich durch Klick auf den Show Robot TCP Trace-Knopf 
anzeigen lassen. 
 

Erzeugen eines LIN-Roboterprogramms in EASY-ROB™ 
 
 

 

Speichern Sie das Programm zunächst mittels des 
Save as-Knopfs im TeachWindow unter dem 
Namen box_prg_ptp_lin.prg ab. Speichern Sie 
dann die Arbeitszelle unter dem Namen 
box_prg_ptp_lin.cel. 
 

Hinzufügen des Unterprogramms für 
LIN 
 
Das Unterprogramm mit den Verfahranweisungen 
für LIN soll vor dem Unterprogramm mit den PTP-
Anweisungen aufgerufen werden. Wählen Sie 
dazu die Programmzeile mit dem Befehl call 
sub_ptp() aus. Drücken Sie dann im TeachWindow 
den Knopf >Cntrl und wählen Sie im nächsten 
Auswahldialog den Knopf CALL FCT. Geben Sie 
als Funktionsnamen sub_lin() ein. Wenn Sie die 
Frage im nächsten Dialogfeld mit ja beantworten, 
so fügt EASY-ROB™ automatisch eine 
Unterfunktion ein. 
 
 

Einfügen der Bewegungsbefehle für 
LIN 
 
Wählen Sie die Programmzeile endfct, welche die 
Funktion sub_lin() abschließt aus. 
 
Fügen Sie die Befehle Home 1 und PTP T_1 
hinzu, da der Roboter zunächst in die Home-
Position fahren soll um dann den ersten Punkt 
mittels einer PTP-Anweisung anzufahren. 
 

Wählen Sie nun die Punkte T_2 bis T_5 im TagWindow aus und klicken Sie nach der Auswahl jeweils auf 
LIN cTag im TeachWindow. Vergessen Sie danach nicht die Punkte T_2 und T_1 ebenfalls mit LIN-
Anweisungen anzufahren. Abschließend wird der Roboter in die Home Position gefahren. 
 
Denken Sie daran, das Programm mittels des Save-Knopfs im TeachWindow zu speichern. 
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Erste Schritte mit EASY-ROB™ 
 

  
 
 

 

So sieht das fertige Programm für LIN- und PTP-
Verfahranweisungen aus.  
 
Tipp: Mit dem > Run Cmd-Knopf aus dem TeachWindow 
können einzelne Verfahranweisungen ausgeführt werden 
(Einzelschritt-Modus). Markieren Sie hierzu die 
entsprechende Programmzeile mit einem Mausklick und 
drücken Sie auf > Run Cmd. 
 

Vergleich des Bewegungsverhaltens bei 
PTP und LIN 
 
Vergleichen Sie das Bewegungsverhalten des Roboters 
in dem Sie den Trace einschalten und einmal das 
Unterprogramm mit den PTP-Verfahranweisungen 
ausführen und dann das Programm mit den LIN-Befehlen 
mittels des Einzelschritt-Modus ausführen. Wechseln Sie 
nach dem PTP-Unterprogramm die Trace-Farbe auf blau. 
Hierzu wählen Sie im EASY-ROB™-Hauptmenü den 
Eintrag View / TCP Trace / Color / Color for desired TCP 
TRACE. 
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Erste Schritte mit EASY-ROB™ 
 

Anpassung der Verfahrgeschwindigkeiten und Verfahrbeschleunigungen 
 

 

 
 

Achten Sie darauf, dass die Bewegungsplaner für 
PTP-, CP- und CIRC-Verfahren jeweils auf Jerkfree 
Vel-Prof. C3 eingestellt sind. Diese Einstellung 
können Sie im Menü Robotics / Robot Motion 
Planner vornehmen. 
 
Hinweis: Bei der Auswahl des Bewegungsplaners 
und der Festlegung von Geschwindigkeiten wird 
zwischen PTP und CP unterschieden. CP bedeutet 
Continuous Path, also Bahnfahren wie LIN oder 
CIRC. 
 
Speicher Sie das Programm mit dem Save as-Knopf 
im TeachWindow unter dem Namen 
box_prg_ptp_lin_speed.prg ab und sichern Sie die 
neue Arbeitszelle unter dem Namen 
box_prg_ptp_lin_speed.cel. 
 

Einstellen von SPEED und ACCEL 
 
Mit dem > Cntrl-Knopf aus dem TeachWindow 
erhalten Sie Zugriff auf die Befehle zum Setzen von 
Geschwindigkeiten und Beschleunigungen (SPEED 
und ACCEL). 

Setzen Sie die Werte für SPEED und ACCEL durch 
Auswahl der entsprechenden Knöpfe wie 
nachstehend aufgeführt: 

        

  
ACCEL_ORI 

 
40  

2

deg

s
 

  
ACCEL_CP 

 
1.500  

2s

m
 

  
SPEED_ORI 

 
5  

s

deg
 

  
SPEED_CP 

 
0.050 

s

m
 

  
ACCEL_PTP_AX 

 
40 40 40 40 40 
40 

2

deg

s
 

  
SPEED_PTP_AX 

 
5.0 5.0 5.0 5.0 
5.0 5.0 

2

deg

s
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Erste Schritte mit EASY-ROB™ 
 

 
 
 

Hinweis: Im Gegensatz zu den SPEED- und ACCEL-Dialogen werden 
im EASY-ROB™-Roboterprogramme die Längenangaben in m statt in 
mm angegeben. 
 

Verifikation des Ergebnis 
 
Rufen Sie über die Symbolleiste den Robot IO Output-Dialog auf und 
wählen Sie aus der Liste den Eintrag current Motion Data. Sie erhalten 
unter anderem Informationen über die Dauer der Simulation, die Dauer 
des Roboters im Einsatz und die Dauer des letzten Bewegungssatzes. 
Darüber hinaus werden die aktuellen Geschwindigkeits- und 
Beschleunigungswerte angezeigt. 

Erweiterung des Programms 
 
Speichern Sie das Programm diesmal unter dem Namen 
prg_ptp_lin_speed_track.prg und die Arbeitszelle unter dem 
Namen box_prg_ptp_lin_speed_track.cel. 
 

Veränderung des Tracks aus dem 
Roboterprogramm 
 
Die Darstellung des TCP Trace können Sie direkt aus dem EASY-
ROB™-Roboterprogramm ein- und ausschalten. Darüber hinaus 
können Sie die Farbe des Tracks beeinflussen. Fügen Sie einfach 
die gelb hinterlegten Zeilen in das Programm ein. Dazu klicken 
Sie den Knopf > ERC im TeachWindow und wählen die Option 
ERC [] ON. Klicken Sie danach auf TRACK. Zur Wahl der Farbe 
wählen Sie die Option ERC COLOR []. Nach Auswahl von 
COLOR TRACK wählen Sie die entsprechende Farbe. 
 

Einfügen einer Programmpause 
 
Zeitlich befristete Programmunterbrechungen können durch den 
WAIT-Befehl gefolgt von der Zeitangabe in Sekunden in das 
Programm eingefügt werden. Der nächste Befehl wird dann erst 
nach Ablauf der festgelegten Zeit ausgeführt. Bei der Zeit handelt 
es sich um Simulationszeit nicht um Echtzeit. 
 
Tipp: Probieren Sie den Effekt indem Sie das Programm einmal 
mit einem WAIT Befehl und einmal ohne WAIT-Befehl durchlaufen 
lassen und sich die Simulationszeit ansehen. Programmzeilen 
können Sie durch ein vorangestelltes Ausrufezeichen 
auskommentieren. 
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EASY-ROB™ Bedienungshinweise 

Short Keys und Start-Optionen 
 
 

 
Die EASY-ROB™ Bedienoberfläche kann mit der Maus und über die Tastatur durch sogenannte ShortKeys 
bedient werden. Die folgende Liste gibt einen Überblick. 
 
EASY-ROB™ - Start mit option und Kommando-Liste 
 
Beispiele: 
 
easyrobw.exe .\proj\Zelle.cel -run -io  Lädt die Arbeitszelle "Zelle.cel", startet das mitgeladene 

Programm automatisch und öffnet das Online Ausgabefenster 
für die Achswinkel des Roboters oder der NC Maschine. 

 
easyrobw.exe -remote -info  Öffnet nach dem Starten den Remote Control Dialog und das 

Message Fenster automatisch. 
 
easyrobw.exe -toolbarsoff - statusbaroff  Startet ohne Toolbars und Statuszeile 
 
easyrobw.exe -loadlib  Öffnet den Load Bibliothek Dialog, Button  
 
easyrobw.exe -prog  -teach   Öffnet das Program- und Teach Window  
 

 
EASY-ROB™ Bedienoberfläche 

 
COMAU Roboter SM5-PAL-260-3.1 
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Short Keys und Start-Optionen 
 

Button oder Menu 
Tastenkombination/ 
Option 

Funktion 

 

 

Toggle Light 
 

-light 3D Szene ohne Lichtquelle darstellen 

 

 

Toggle Point, Vertices 
 

Ctrl + P 
-point 

3D-Geometrien in Punkte-Darstellung 

 

 

Toggle Wire Frame 
 

Ctrl + W 
-wire 

3D-Geometrien in Drahtmodell-Darstellung 

 

 

Toggle BBox 
 

Ctrl + B 
-bbox 

3D-Geometrien in bounded Boxes 

 

 

Toggle Backface Culling 
 

Ctrl + Shift + B 
-bface 

Backface Culling 

 

 

Toggle Floor 
 

-flooroff Zellenboden aus 

 

 

Floor Position 
 

-floorwire Zellenboden dargestellt im Drahtmodell 

 

 

Open avi recorder dialog 
 

F6 Open AVI recorder 
dialog 

Startet AVI Recorder Dialog 

 

Toggles: Simulation View 
or CAD-Preview 

Ctrl + Tab Wechsel: Simulation und Preview 

 

 

 

Run Program 
 

Ctrl + R 
-run 

"Run" Start Programm 

 
                              Pause/Continue 
 

 Fortsetzen/ Anhalten des Programms 

 

 

Abort Program 
 

 Programm-Abbruch 

 

Stops program execution 
after each motion 
command 

 
Automatischer Programm-Stop nach jedem 
Programmierbefehl 

 

Repeats program 
automatically 

-runrepeat Automatische Programmwiederholung 

 
3D Animation On/Off  

Aktivieren/Deaktivieren der 3D-Animation 
während der Simulation 

 

 

Decrease Stepsize 
 

Ctrl + '+' Simulations-Schrittweite verringern 

 

 

Increase Stepsize 
 

Ctrl + Shift + '-' Simulations-Schrittweite erhöhen 
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Short Keys und Start-Optionen 
 

 

Display miscellaneous 
output values 

-io -io2 -io3 -io4 
Öffnet die ersten 4 Ausgabe Fenster 
(desired Joint Values, desired Cart. Pose, 
current Motion Data, actual  Joint Values) 

 

Button oder Menu 
Tastenkombination/ 
Option 

Funktion 

 
File → Load → Cell file 

Ctrl + O 
-loadcel 

Laden/öffnen einer Arbeitszelle 

File → Load → Robot file -loadrob, -loadrobot Öffnet Dialog zum Laden des Roboters 

File → Load → Tool file -loadtol, -loadtool Öffnet Dialog zum Laden des Tools 

 

File → Load → Load from 
Library 

Ctrl + Shift + O 
-loadlib 

Laden von Zellen, Robotern, Tools, etc. aus 
der Bibliothek, Visual File Interface 

 File  → Load → Start  
 Project Manager 

Ctrl + Shift + P Startet den Projektmanager 

 File  → Load → Start  
 ERC Searcher 

Ctrl + Shift + S Startet den ERC Searcher 

 File  → Load → Start  
 History Diagram 

Ctrl + Shift + H Startet History Diagram 

 File  → Load → Start  
 CAD2ER Converter 

Ctrl + Shift + C Startet CAD2ER Converter 

 
File → Save → Cell file Ctrl + S Speichern/ Speichern unter der Arbeitszelle 

 File → Unload → Cell Ctrl + U Entladen der Arbeitszelle 

File → Edit → EASY-ROB System 
Files → Config file 

Alt + Shift + C Editieren der Datei config.dat 

File → Edit → EASY-ROB System 
Files → Environment file 

Alt + Shift + E Editieren der Datei easy-rob.env 

File → Edit → EASY-ROB System 
Files → License file 

Alt + Shift + L Editieren der Datei License.dat 

File → Edit → EASY-ROB System 
Files → Moni_msg file 

Alt + Shift + M Editieren der Datei moni_msg.txt 

File → Exit 
Ctrl + F4, 
Alt + F4 

EASY-ROB beenden 

? → Online Help F1  Online Hilfe aufrufen 

? → License Info -licenseinfo Lizenz Information 

? → About... -about Öffnet Dialog "About" 

 

Simulate →Programs →  
Teach Window 
Open Prgram Teach 
Window 

-teach Öffnet Teach Dialog 

 

Simulate →Programs →  
Progam Output 
Show Program Window 

-prog Öffnet Program Dialog 

 

(2x) Tags →Tag Window  
 

-tag Öffnet Tag Dialog 
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Short Keys und Start-Optionen 
 

 

 

(2x) 3D-CAD → 3D-CAD 
Window 

-3dcad Öffnet 3D-CAD Dialog 

 

Button oder Menu 
Tastenkombination/ 
Option 

Funktion 

 
 

 

View → Coorsys → 
Show Robot Coorsys 

-robcoorsys 

Koordinatensysteme in den Achsen des 
Roboters anzeigen 
 

  

View → Message Window 
Ctrl + M, 
-message 

Öffnet Message Dialog 
(Informationsausgabe) 

View → Navigator Window Ctrl + N 
Öffnet Navigator Dialog (Pick & Click, 
Abstände messen, etc.) 

View → Status Bar -statusbaroff Programm-Statuszeile aus 

View → Coorsys → Show Robot 
Coorsys 

-robcoorsys 
Koordinatensysteme in den Achsen des 
Roboters anzeigen 

View → EASY-ROB PlugIn Dlls → 
Avi Recorder 

-avi 

Öffnet Avi-Recorder Dialog 

 

View → Show Toolbars → All 
Toolbars On 

Ctrl + T 
-toolbaron 

Alle Toolbars ein 

View → Show Toolbars → All 
Toolbars Off 

Ctrl + Shift + T 
-toolbaroff 

Alle Toolbars aus 

View → Show Toolbars → 
Load/Save 

-toolbarloadsaveoff Alle Toolbars aus 

View → Show Toolbars → Render -toolbarrenderoff Render Toolbar aus 

View → Show Toolbars → Run/ 
Animation 

-toolbarrunoff Run Toolbar aus 

View → Show Toolbars → On/Off -toolbaronoffoff On/Off Toolbar aus 

View → Show Toolbars → 3DCAD -toolbar3dcadoff 3D CAD Toolbar aus 

View-> Show Toolbars-> Move 
Robot to 

-toolbarmovetooff Move to Toolbar aus 
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View → Show Toolbars → Mouse 
Mode 

-toolbarmouseoff Mouse Move Toolbar aus 
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Short Keys und Start-Optionen 
 

Button oder Menu 
Tastenkombination/ 
Option 

Funktion 

View →Show Toolbars → Robot 
Toolbar 

-toolbarselectrobot Roboter Toolbar aus 

Robotics → Robot Application → 
Remote Control 

F2 
-remote 

Remote Control Dialog starten 

Robotics → Robot Application → 
External Devices → Sensor 
Interface 

F3 
-sensor 

Öffnet Sensor Interface Dialog 

View → EASY-ROB PlugIn Dlls 
Vrml97 Export 

F7 Startet VRML97 Export Dialog 

View → Set 3D Views → Goto 
next Simulation View 

Ctrl + Tab Zur nächsten Simulations-Ansicht schalten 

View → Set 3D Views → Goto 
prev Simulation View 

Ctrl + Shift + Tab Zur vorherigen Simulations-Ansicht schalten 

 

3D CAD → Attributes → Info Ctrl + I 
Geometrieinformation des aktuellen CAD 
Körpers 

3D CAD → Cad Preview Settings 
→ Info 

Ctrl + Shift +I 
Geometrieinformation des CAD Körpers in 
der PreView 

 

 
 

 

 
Spacebar/ Leertaste 

 
 

 
→ 
 
 
 

→ 

Toggelt zwischen dem vorherigen und dem 
aktuellen "MouseMode" 
 
WorldView  →  Jog Robots TCP Tool 
Jog Robots TCP Tool  →  WorldView 
 

Aux → EASY-ROB Client Window -client 
Öffnet ein weitere EASY-ROB™ Sitzung, 
wobei die gleiche Arbeitszelle geladen wird. 

 
Aux → Mouse Mode → TCP Tool 
 
Aux → Mouse Mode → Abs | Rel 
 
Aux → Mouse Mode→ Rot | Trans 
 

 

MouseMode   
 
 
Shift     →  
 
 
Ctrl      → 

Ist der Mouse-Modus "Tcp Tool" aktiv, kann 
während der Mausbewegung durch Drücken 
der Shift- und/oder Crtl-Taste auf 
absolute/relative Bewegung bzw. 
translatorisch/ rotatorisch umgeschaltet 
werden. 
 
Status-Zeile   
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Aux → Mouse Mode → TCP World 
 
Aux → Mouse Mode → Abs | Rel 
 
Aux → Mouse Mode→ Rot | Trans 
 

 

MouseMode 
 
 

Shift     → 
 
 

Ctrl       → 

Ist der Mouse-Modus "Tcp World" aktiv, 
kann während der Mausbewegung durch 
Drücken der Shift- und/oder Crtl-Taste auf 
absolute/relative Bewegung bzw. 
translatorisch/ rotatorisch umgeschaltet 
werden. 
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Short Keys und Start-Optionen 
 

Button oder Menu 
Tastenkombination/ 
Option 

Funktion 

Aux → Mouse Mode → Joint 
 
 

 
 

 
 2 x  
 

 
 
 
 
 
MouseMode   
 

 
 
ESC 
 
Ctrl 
 

 
 
 
 
 
 
 
ESC setzt die Achswinkel zurück 
 
Mit der Ctrl-Taste wird während der 
Mausbewegung auf die Achsen 4-6 
geschaltet. Beim Loslassen wieder auf die 
Achsen 1-3. 
 

Zweimaliges Klicken auf   startet den 
JogWindow Dialog 

Aux → Mouse Mode  → World 
View 
 

 
 

 

 Cruise Mode Auswahlmöglichkeiten 

  
 
 2 x  
 
 

 
 
 
MouseMode   
 

 
 
ESC 
 
 
 
 
 
 
 
 
 
 
 
Ctrl-Key 
 
 
 
 
 
Shift-Key 
 

Ist der Mouse-Modus "World View" aktiv, 
kann durch Drücken der TAB-Taste in die 
Kameraperspektive umgeschaltet werden 
und zurück. 
 
ESC setzt die „3D-View“ zurück 

Zweimaliges Klicken auf   startet den  
 
Navigator Dialog (Pick & Click, Abstände 
messen, etc.) 
 
Im Navigator Window kann der Cruise Mode 
festgelegt werden, um den die 3D Szene 
gedreht wird.  

 
Wird zuerst die Ctrl-Taste, wird der Cruise 
Mode auf Robot TCP gesetzt. Somit ist der 
aktuelle Drehpunkt der TCP des Roboters. 
 
Wurde zuvor mit Pick & Click ein Punkt, 
Polygon oder Tag ausgewählt und es soll 
um diesen Punkt gedreht werden, so 
drücken Sie die Shift-Taste. Der Cruise 
Mode wird auf „picked Point“ gesetzt und 
bestimmt den aktuellen Drehpunkt der 3D 
Szene.. 
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Short Keys und Start-Optionen 
 

Button oder Menu 
Tastenkombination/ 
Option 

Funktion 

 
Aux → Mouse Mode → Trans/Rot 
current selected Tag 

 

 
 

  2 
x  
 
 
 

 
 
 
 
 

MouseMode 
 
 
Shift      → 
 
 
Ctrl        → 
 
 
Arrow UP 
Arrow Down 
 
Pos 1 (home) 
Ende (end) 
 
ESC 

Ist der Mouse-Modus "Trans/Rot current 
selected Tag" aktiv, kann während der 
Mausbewegung durch Drücken der Shift- 
und/oder Crtl-Taste auf absolute/relative 
Bewegung bzw. translatorisch/ rotatorisch 
umgeschaltet werden. 
 
Durch Drücken der Pfeil Hoch/Runter Tasten 
können die Tagpunkte selektiert werden. 
Der Name des aktuellen Tagpunktes wird in 
der Statuszeile angezeigt. 
 

  
 
Taste <Pos 1> selektiert den ersten 
Tagpunkt, Taste <Ende> den letzten 
Tagpunkt des Pfades. 
 
Absolut: Bewegung bzgl. Wobj-Frame 
Relativ: Bewegung im Tag-Frame 
 
ESC setzt die Tag Position zurück 

 
EASY-ROB™ Status-Zeile 
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EASY-ROB™ Bedienungshinweise 

Allgemeine Funktionen 

Positionierung des Fußbodens 

 

 
Einige Maschinen haben den Nullpunkt im EASY-ROB-Weltursprung. Bisher konnte man entweder den 
Fußboden unsichtbar setzen oder den Maschinennullpunkt verlegen, damit die Maschine „auf dem Boden 
steht“ und nicht „darin“. 
Mit der aktuellen Version können Sie die Position und die Orientierung des systemeigenen Fußbodens in 
EASY-ROB frei variieren bzw. definieren  und somit an die Bedürfnisse anpassen. 
 
Über das Menü „View | Floor | Floor Position“ rufen Sie den Frame Dialog auf. 
 

 

Siehe hierzu auch das Kapitel „Frame Dialog“ 

  

Boden verschieben  
in x, y oder z- Richtung 

Boden verdrehen  
um x, y oder z- Richtung 
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EASY-ROB™ Bedienungshinweise 

Allgemeine Funktionen 

TCP TRACE 

 

 
Bei der Darstellung der Spur des Tool Center Points gibt es unterschiedliche Varianten. So kann neben der 
Art, der Farbe und der Stärke auch der „Befestigungspunkt“ verändert werden. 
 
Zu den Settings gelangen Sie über das Menü  View | TCP Trace | 
 

 

 
 

 
TCP Trace ein- bzw. ausschalten 

 

 
 

 
Einstellung Typ: 
Line   Trace wird als Linie angezeigt 
Point   Trace wird als Punktlinie angezeigt    
Line + Z  Linie und Approach-Achse in Z 
Z App.   Approach-Achse in Z 
X App.   Approach-Achse in X 
Y App.   Approach-Achse in Y 

 

 
 
 

 
 

 
Auswahl der Farbe für den TCP Trace 

TCP Trace  ein- bzw. 
ausschalten  

Änderung Typ  

Änderung Farbe 

Änderung Länge / Stärke 

Änderung 
Ursprung/Befestigungspunkt 
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TCP TRACE 
 

 

 
 
 

 
 
 

 
 
 
 
 
Änderung der  

- Stärke des TCP Trace 

 
 
 

- Approach Länge des TCP Trace 
 

 
 
 

- Punktstärke des TCP Trace 
 

 

 
 
 

 
 

 
Auswahl des Befestigungspunktes des TCP 
Trace 
 
Möglichkeiten: 

- bezogen auf den Weltenursprung 
- bezogen auf Roboterbasis 
- bezogen auf ein bestimmtes Gelenk 
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EASY-ROB™ Bedienungshinweise 

Allgemeine Funktionen 

Kollisionsprüfung in EASY-ROBTM 

 

 
Mit der Kollisionserkennung in EASY-ROBTM können unterschiedliche Objekte in der Arbeitzelle auf 
mögliche Kollision geprüft werden. 
 
Es können einzelne Objekte oder Gruppen gegeneinander geprüft werden. So kann man z.B. nur die 
Achsen 5 und 6 eines Roboters gegen den Schutzzaun prüfen, wenn man genau weiß, dass alle anderen 
Achsen aufgrund ihrer Verfahrwege den Zaun sowieso nicht erreichen können. 
Diese Minimierung der Anzahl der zu prüfenden Bauteile verkürzt die Berechnungszeit bei der 
Kollisionserkennung. 
 
Der interne Mechanismus der Kollisionserkennung ist hierarchisch: zuerst erfolgt eine bounding box 
Erkennung, bevor im nächsten Schritt auf konvex oder konkav geprüft wird. 
 
Der Kollisions-Check wird nicht nur während des Programmablaufs durchgeführt – auch beim manuellen 
Bewegen des Roboters mittels des Verfahrens des TCP oder der einzelnen Joints wird die Prüfung 
durchgeführt. 
 
Tritt Kollision auf, wird dies durch Veränderung der Farbe der kollidierenden Bauteile oder durch Stopp der 
Simulation angezeigt. 
 
Zusätzlich zur direkten Kollisionen, kann auch auf „Beinahe-Kollision“ oder „Mindest-Abstand“ geprüft 
werden. Hierzu muss ein „Sicherheitsbereich“ definiert werden – z.B. 10 mm. Wird dieser 
Sicherheitsbereich unterschritten wird sofort Kollision angezeigt, obwohl noch keine echte Kollision 
stattgefunden hat. 
 
 
Alle Funktionen hinsichtlich der Überprüfung auf Kollision können zu jeder Zeit sowohl manuell über die 
Buttons als auch automatisch mittels ERCL Befehlen im Programm geschaltet werden.  
(siehe hierzu auch Dokument „EASY-ROB_ERPL_DE.pdf“, Dokumentation aller ERCL-Befehle) 
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Kollisionsprüfung in EASY-ROBTM 

 

 
Um dem User größtmöglichen Handlungsspielraum zu geben, ist der Mechanismus für die 
Kollisionserkennung in 3 Ebenen unterteilt. 
 

1. globaler Ein-/Ausschalter Kollisionsprüfung 
 

 
2. vorgefertigte Kollisionsketten  

Mittels Ein- oder Ausschalten von vorgefertigten Kollisionsketten kann der User die einzelnen 
Gruppen gegeneinander prüfen. Im einzelnen sind das folgende Kollisionsketten: 
 
BODY_ROBOT  – prüft die Kollision zwischen Body und Roboter 
BODY_TOOL   – prüft die Kollision zwischen Body und  Tool 
ROBOT_TOOL  – prüft die Kollision zwischen Roboter und Tool 
GRABBODY_ROBOT  – prüft die Kollision zwischen „gegriffenem“ Body und Roboter 
GRABBODY_ BODY  – prüft die Kollision zwischen „gegriffenem“ und „nicht-gegriffenem“  Body  
ROBOT_ROBOT  – prüft die Kollision zwischen allen Geometrien in derselben Robotergruppe  
BODY_BODY   – prüft die Kollision zwischen allen Geometrien in derselben Bodygruppe  
 

 
3. Kollisionsattribute auf Objekt-/Geometrieebene 

Jedes Objekt bzw. jede Geometrie hat (neben anderen Attributen) ein Attribut mit dem Namen 
„Check Collision“ für die Kollisionserkennung. 
Hier kann für jedes Objekt bzw. jede Geometrie festgelegt ob und wie auf Kollision geprüft werden 
soll. Die möglichen Parameter sind folgende: 
 
OFF  - keine Überprüfung auf Kollision für das Objekt 
BBOX  - Überprüfung nach „bounding boxes“ 
CONVEX - Überprüfung konvex 
CONCAVE - Überprüfung konkav 
 
Standardmäßig ist die Prüfung „CONCAVE“ eingestellt. 
 
Anmerkung: Ist bei einem Bauteil BBOX oder CONVEX und beim anderen Bauteil CONCAVE 
eingestellt, so wird die Prüfung auf CONCAVE durchgeführt. 

 
 
 
ACHTUNG: 
Zu beachten ist bei der Nutzung der Kollisionsüberprüfung, dass auf allen drei Ebenen die „Schalter“ korrekt 
gesetzt sind, um ein entsprechendes Ergebnis zu erhalten. Nachfolgend ein paar Beispiele: 
 
Fall a)  
Kollisions-Check eingeschaltet, Kollisionskette Body-Robot ist „ON“, das Attribut „Check Collision“ ist „OFF 
-> auch wenn eine Kollision existiert, wird keine Kollision angezeigt, da das Attribut für die Geometrie auf 
den Wert „OFF“ gesetzt ist 
 
Fall b)  
Kollisions-Check eingeschaltet, Kollisionskette Body-Robot ist „OFF“, das Attribut „Check Collision“ ist 
„CONCAVE“ 
-> auch wenn eine Kollision existiert, wird keine Kollision angezeigt, da die Kollisionskette auf den Wert 
„OFF“ gesetzt ist 
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Kollisionsprüfung in EASY-ROBTM 
 

 
Eine Übersicht der Abhängigkeiten der 3 Ebenen zur Kollisionserkennung: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

COLLISION 

ON 

OFF 

COLLISION QUEUE 
 
BODY_ROBOT 
BODY_TOOL 
ROBOT_TOOL 
GRABBODY_ROBOT 
GRABBODY_ BODY 
ROBOT_ROBOT 
BODY_BODY 
ALL 

ON 

OFF 

COLLISION BODY 
oder 
COLLISION BODY_GRP 

CONCAVE 
oder 
CONVEX 
oder 
BBOX 

OFF 

Check and Display 
COLLISION 

NO Check and NO 
Display COLLISION 
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Kollisionsprüfung in EASY-ROBTM 
 

 

 
 

Ein- bzw. Ausschalten der Kollisionsprüfung 

 

 
 

Öffnen des Bediendialog zum Ein- bzw. 
Ausschalten der Kollisionsketten. 

 

 
 

 

 

 

 

Bediendialog zum Ein- bzw. Ausschalten  

der Kollisionsketten 

 

Mit Doppelklick auf dem Eintrag wird zwischen 

ON und OFF geschaltet 

 

 
 
 
 

 
 

 

 

Attribute „Check Collision“ auf „Concave“ gesetzt. 

 

 

 

 

 

 

 

 

Mit Doppelklick auf dem Attribut wird der Dialog 

zum Ändern des Zustands geöffnet. 
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EASY-ROB™ Bedienungshinweise 

Allgemeine Funktionen 

Exportieren einer Arbeitszelle 

 

 
Immer wenn ein Bediener eine EASY-ROBTM Arbeitszelle z.B. per E-Mail an einen Kollegen oder Kunden 
schicken möchte (jemand, der also nicht auf demselben PC oder im selben Netzwerk arbeitet) ergibt sich 
folgende Frage: 
“Sind alle erforderlichen Daten in der Sendung enthalten?!” 
 
Enthält die Arbeitszelle mehrere Devices, die wiederum aus mehreren Parts bestehen und auch noch ein 
Programm dabei ist, kann es unter Umständen sehr zeitraubend sein, sämtliche Einzelteile 
zusammenzustellen. 
 
 
Die EASY-ROB™ Funktion “Export Workcell” unterstützt den Bediener dabei, alle Arbeitszellen-bezogenen 
Daten zusammenzustellen.  
Die Funktion kopiert die aktuelle Arbeitszelle und alle darin verwendeten Daten wie z.B. IGP-Dateien und 
Programme in einen neuen Ordner. 
 
 
 

 
1. 
Laden Sie die Arbeitszelle  
 
Spotweld_Demo.cel 
 
mit dem Button  
“Start Device Manager” 
aus dem Verzeichnis:   
 
../EASY-ROB / ApplicationLib / 
Spotwelding 
 

 
 
oder Shortcut „Ctrl+Shift+O“ 
 

 

 
2. 
Starten Sie über das Menü  
File | Save | Cell File Export 
den Export 
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Das Exportieren einer Arbeitszelle 
 

 
3. 
Setzen die Positionen zurück und 
überschreiben Sie die bestehende 
Arbeitszelle 
 

 

 
4. 
Jetzt wählen Sie das 
Standardverzeichnis oder erzeugen 
Sie ein neues Zielverzeichnis, um die 
Daten zu speichern. 
 
Der Default-Pfad ist das 
Zielverzeichnis der EASY-ROBTM 
Installation: 
C:\Programme\EASY-ROB 
 
in einem Unterverzeichnis mit dem 
Namen  
“\EASY-ROB\Proj-
Export\TARGET_DIR” 
 
Bestätigen Sie hier den Default-Pfad  
mit “Speichern” 
 

 
 

 
 
 
 

 
5. 
Bestätigen Sie die nächste Frage mit 
“Ja”,  
 
um das Batch file zu starten und 
somit die Daten in das gewählte 
Verzeichnis zu exportieren. 
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Das Exportieren einer Arbeitszelle 
 

 
7. 
Nachdem der Batchlauf 
abgeschlossen ist, drücken Sie eine 
beliebige Taste um die Command 
Shell zu schließen. 
 
 
 

 

 
 
 

 
8. 
Alle Arbeitszellen-bezogenen Daten 
wie:  

- Workcell-Datei 
- Programm 
- Mimic 
- Parts 

wurden in das gewählte Verzeichnis 
kopiert. 
 
C:\Programme\EASY-ROB\EASY-
ROB\Proj-Export\proj 
 
Die Parts aller Devices befinden sich 
im igp-Ordner. 
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EASY-ROB™ Bedienungshinweise 

Dialoge & Windows 

Device Manager 

 

 
Der Device Manager bietet dem Bediener die Möglichkeit ohne die Arbeitszelle oder den Roboter zu laden, 
in die betreffende Datei „hineinzusehen“. Aufgrund der über den Device Manager bereitgestellten 
Informationen kann der Bediener sofort erkennen, ob es sich um die gewünschte Arbeitszelle oder den 
Roboter handelt, und dann die Datei laden. 
Neben einem Screenshot der Arbeitszelle oder des Roboters können auch Informationen als Text hinterlegt 
werden. 
Über eine „Pfadhistorie“ und die Liste der „bevorzugten Pfade“ kann der Bediener mit wenigen Mausklicks 
durch den Verzeichnisbaum navigieren. 
 
Außerdem bietet der Device Manager die Möglichkeit bestimmte Daten an den Project Manager zu senden. 
(lesen Sie hierzu auch das Kapitel „Project Manager“ in diesem Dokument)  
 

 
1. 
Öffnen Sie den Device Manager über den Button 
„Start Device Manager“ oder mit dem Shortcut 
Ctrl+Shift+O: 
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Device Manager 
 

 

 
 

 
Pfadhistorie: 
 
Lädt der Benutzer eine Zelle oder einen Roboter in 
EASY-ROB™, wird der Pfad  aus dem die Datei 
geladen wurde in die Pfadhistorie an erster Stelle 
gespeichert. 
Maximal werden 12 Pfade abgelegt, wobei gleiche 
Pfadnamen nur einmal gelistet sind. 
 
 
Die Datei „er_LoadFromLibPb.ini“ , in der die 
Pfadhistorie gespeichert ist, wird automatisch 
verwaltet und sollte nicht manuell editiert werden 

 

 
 
 

 
Bevorzugte Pfade: 
 
Im Unterschied zu der automatisch erzeugten 
Pfadhistorie, bleiben die „bevorzugten Pfade“ 
unverändert und ermöglichen dem Bediener so 
einen schnellen Zugriff auf seine 12 wichtigsten 
Pfade 
 
Diese „bevorzugten Pfade“ sind vom Bediener 
anzulegen und werden in der Datei 
„er_LoadFromLibPb_prefered.ini“ im EASY-ROB™-
Hauptverzeichnis  gespeichert und können über 
Menü/File/Edit/EASY-ROB-SystemFiles editiert 
werden. 

 

 
 

 
Auswahl des anzuzeigenden Dateityps 
in der Dateiliste 

 

 
 

Mit der Eingabe eines Suchbegriffs im 
Eingabefeld und einem Klick auf „search“ kann 
nach Devices gesucht werden.. 

 

Daten der Arbeitszelle an den Project 
Manager senden 

 

Funktion zum Erstellen eines 
Screenshots 

 
Laden der gewählten Datei 

 
Abbruch der Funktion 

  

mailto:info@easy-rob.com
http://www.easy-rob.com/


 

Technische Änderungen und Verbesserungen sind vorbehalten 59/109 

  
EASY-ROB Software GmbH  Hauptstr.42  65719 Hofheim am Taunus  Germany  Tel. +49 6192 921 70-77  Fax. +49 6192 921 70-66  info.er@easy-rob.com  www.easy-rob.com 
 

EASY-ROB™ Bedienungshinweise 

Dialoge & Windows 

Capture Image 

 

 
Im EASY-ROB™ Capture Image Dialog kann der Bediener wahlweise Screenshots im BMP- oder JPEG 
Format erzeugen. 
 

 
1. 
Laden Sie zunächst über den Library Dialog den 
Roboter oder die Arbeitszelle ins EASY-ROB™ 
 

 

 
2. 
Nach dem Laden der Zelle oder des Roboters 
wird im EASY-ROB™ Device Manager „Capture 
Image“ aufgerufen. 
 
 

Tipp:  Markieren Sie zuerst die 
gewünschte Datei  
(im Bild „multi_paint_01.cel“), 
bevor Sie „Capture Image“ 
aktivieren.  
Nur so wird der Dateiname für 
das Bild übernommen. 

 

 

 
 

 
3. 
Positionieren Sie das Motiv im „Capture Image 
Fenster“ nach Belieben.  
 
Mit „Shoot“ wird vom gewählten Ausschnitt eine 
BMP- oder JPEG-Datei erzeugt. 
 
 
Das Bild wird im selben Verzeichnis gespeichert, 
in dem auch die Arbeitszelle gespeichert ist. 
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EASY-ROB™ Bedienungshinweise 

Dialoge & Windows 

Navigator Window 

 
 

Das Navigator Window wird verwendet, um in der 3D Szene Geometrien und Tagpunkte anzuwählen und um 
Distanzen zu messen. Mit der Einstellung des  Cruise Mode  wird festgelegt, um welchen Punkt  Cruise-
Drehpunkt  im Raum die 3D Szene gedreht werden soll. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Auswahl für Messungen  

Select Body/Tag 
Wählen Sie mit der linken Maustaste eine Geometrie oder 
einen Tagpunkt an. Dieses Objekt ist aktuell (current). 

Point Measure 
Wählen Sie mit der linken Maustaste einen Punkt an einer 
Geometrie an, um die Punktkoordinaten anzuzeigen. 

Distance Measure 
Zur Abstandsmessung zwischen Punkten, Flächen und 
Tagpunkten. 

 

Cruise-Drehpunkt festlegen 

 

Durch Auswahl von  Modify World View  mit            wird  
die 3D Szene verschoben, hinein- und  
hinausgezoomt und um einen Punkt im Raum gedreht. 

Als Drehpunkte stehen folgende Bezugssysteme zur Verfügung. 

• World Coorsys: (Grundeinstellung) 
Cruise-Drehpunkt ist das Weltkoordinatensystem. 

• Robot Base: 
Cruise-Drehpunkt ist das Roboter Basissystem. 

• Robot TCP: 
Cruise-Drehpunkt ist der TCP des Roboters. 

• current Body: 
Cruise-Drehpunkt ist das Koordinatensystem der aktuellen 
Geometrie oder des Tagpunktes. 

• picket Point: 
Cruise-Drehpunkt ist der ausgewählte Punkt an der Geometrie. 

Auswahl für Messungen 

Festlegung des Cruise-
Drehpunktes in der 3D Szene 

Kameraeinstellungen 
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Navigator Window 
 

Mit der Leertaste (Spacebar) kann zwischen dem aktuellen Mouse Mode und dem letzten Mouse Mode 
hin- und hergewechselt werden. 
 

 
 
 

Kamera-Einstellungen 
 
 
 
 
 
 

Mit der Kamera werden optimale Blickwinkel eingestellt. Sie ist 
idealer Weise einer Geometrie zugewiesen. Ist der Mouse Mode 
„Modify World View“  aktiv, kann mit der TAB-Taste zwischen 
Kamera- und Welt-View hin- und hergewechselt werden 
 
Die Blickrichtung ist gemäß OpenGL™ Definition immer in die 
negative Z-Richtung. 

 

 
 

Der Fokus wird pro Klick um 10 mm verändert. 
Um einen genauen Fokus-Wert einzustellen → Doppelklick auf 
Focus length in der Eigenschaften-Liste. 

 Der Z Offsetwert verschiebt die Linse in z-Richtung (Blickrichtung)  
Mit jedem Klick ändert sich der Z offset um 10mm. 
Um einen genauen Offsetwert einzustellen → Doppelklick auf  
Z offset in der Eigenschaften-Liste. 

 
 

Eigenschaften-Liste 

 

Mit einem Doppelklick auf einen Wert in der Eigenschaften-Liste 
können genaue Zahlenwerte eingegeben werden. 
 
 
 

Auswahl an welcher Geometrie 
oder welchen Punkt die Kamera  
"attached" werden soll.  

 
 
 
 

Offsetverschiebung und -drehung  
bezogen auf das Bezugssystem der Kamera. 

Ein / Ausschalten 
der Kamera Dialog beenden 

Kameraeinstellungen zurücksetzen 

Kameraeinstellungen übernehmen 

Geometrie auswählen 

Eigenschaften
-Liste 

Focus und Offset 
Einstellung 
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EASY-ROB™ Bedienungshinweise 

Dialoge & Windows 

Frame Dialog 

 

 
Der Frame Dialog dient zur Eingabe von kartesischen Koordinaten. Um beispielsweise 3D Geometrien, die 
Roboterbasis oder den TCP’s des Roboter neu festzulegen, werden im Frame Dialog die aktuellen X-, Y- und 
Z-Werte mit Orientierung angezeigt und können geändert werden. Die neuen Koordinaten werden sofort 
visualisiert, ohne den Dialog zu schließen, womit sich die Eingaben schnell überprüfen lassen. Weiterhin 
können aktuelle Positionen gespeichert werden, um sie anderweitig zu verwenden. Auch das Multiplizieren 
und Invertieren von homogenen Matrizen (Frames) ist möglich. 
 
Der Frame Dialog zählt zu den zentralen Benutzerdialogen in EASY-ROB™ und wird bei der Bedienung am 
häufigsten benutzt. 

 
 

 
Schließt den Frame Dialog und übernimmt die eingegebenen Koordinaten. 

 
Kurzinfo zum Frame Dialog. 

 

Aktualisierung der 3D Szene entsprechend der eingegebenen Koordinaten. 
“GrafikUpdate“  bietet so sich zu einer schnellen Überprüfung der 
Koordinaten an, ohne den Frame Dialog zu verlassen. 

 
Rücksetzen auf die Ausgangskoordinaten als der Frame Dialog geöffnet 
wurde. 

 
Kopiert die Koordinaten in die Frame-Liste (Zwischenablage). 
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Frame Dialog 
 

 
Kopiert die Koordinaten aus der Zwischenablage. 

 
Setzt die Koordinaten und Orientierung auf null, bzw. Einheitsmatrix. 

 
Schließt den Frame Dialog ohne die Änderungen zu übernehmen. 

 Die Informationszeile zeigt die Zugehörigkeit der Koordinaten an. 

 

 
 

Koordinaten-Eingabefelder für Position und Orientierung. 
 
Auch Formeln sind erlaubt, z.B. „200.0+57.3*pi/180“, „0.2*m2mm“, 
„100*sin(45*RAD)“, „a1=5;8*a1“ oder „3*a1“ 
Wechseln sie mit dem Cursor in ein anderes Edit-Feld um die Berechnung 
ausführen zu lassen. 
 
Dist. errechnet die Betrag aus dem x-, y- und z-Wert aus. 

 

Die Schrittweitenvorgabe gibt einen „Deltawert“ vor, um den ein 
Koordinatenwert inkrementiert oder dekrementiert werden soll. 

 

Die Positionskoordinate x, y, oder z wird mit einem Klick auf die folgenden 
Schaltflächen 
 

- -dx  oder  +dx  in x Richtung 
- -dy  oder  +dy  in y Richtung 
- -dz  oder  +dz  in z Richtung 

 
um die Schrittweitenvorgabe „dist“ verändert. Die Änderung erfolgt absolut 
oder relativ. Die 3D Szene wird zur Kontrolle sofort aktualisiert. 

 

Die Orientierungskoordinate Rx, Ry, oder Rz wird mit einem Klick auf die 
folgenden Schaltflächen 
 

- -Rx  oder  +Rx  um x Richtung 
- -Ry  oder  +Ry  um y Richtung 
- -Rz  oder  +Rz  um z Richtung 

 
um die Schrittweitenvorgabe „dR“ verändert. Die Änderung erfolgt absolut 
oder relativ. Die 3D Szene wird zur Kontrolle sofort aktualisiert. 

 
Die Änderung erfolgt absolut im Bezugssystems Tneu = dT(dist,dR) * Talt 

 
Die Änderung erfolgt relativ Tneu = Talt * dT(dist,dR) 

mailto:info@easy-rob.com
http://www.easy-rob.com/


 

Technische Änderungen und Verbesserungen sind vorbehalten 65/109 

  
EASY-ROB Software GmbH  Hauptstr.42  65719 Hofheim am Taunus  Germany  Tel. +49 6192 921 70-77  Fax. +49 6192 921 70-66  info.er@easy-rob.com  www.easy-rob.com 
 

Frame Dialog 
 

 

 
Vorgabe der Orientierungskonvention und  
Umrechnung der aktuellen Orientierung 
in andere Handgelenksdefinitionen. 
 
z.B. • ABB S4 Quaternionen 
 • KUKA KRC1 RzRyRx 
 • Stäubli RzRyRz 
 • Fanuc Karel RJ Roll Pitch Yaw 
 • Tricept TR8x5 Rz(C)Rx(A) 
 
 
 

 
 

 
Frame-Liste für Matrizenberechnung. 
 
Koordinaten werden verrechnet, indem die aktuellen Koordinaten 
(bezeichnet als Matrix T1) zuerst in die Zwischenablage (dort als Matrix T2 
bezeichnet) kopiert werden. 
 
Die homogene Matrix T2 lässt sich nun invertieren oder mit einer aktuellen 
Koordinate T1 verrechnen. 
 
Das Ergebnis in T2 kann aus der Zwischenablage nach T1 zurückkopiert 
und dort weiterverarbeitet werden. 
 
Besonderheit: 
Ein Doppelklick in der Frame-Liste  auf z.B. „1 - X: 1000.000“ bewirkt, dass 
der Wert in die X-Koordinate übernommen wird. Gleiches gilt für die Y- und 
Z-Koordinate und für die Orientierungskoordinaten. 
 

 
Vertauscht Matrix T1 mit Matrix T2. 

 

Setzt nach erfolgter Berechnung die Matrix T2 auf den ursprünglichen Wert 
zurück. 

 
Matrizenmultiplikation T2 = T2 * T1 

 
Matrizenmultiplikation T2 = T1 * T2 

 
Matrizenmultiplikation T2 = T2

-1 * T1  

 
Matrizenmultiplikation T2 = T1

-1 * T2  

 
Matrizeninversion T2 = T2

-1  
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EASY-ROB™ Bedienungshinweise 

Dialoge & Windows 

3D CAD Window 

 

 
Das 3D-CAD Window dient zum Importieren und Positionieren von 3D Geometrien, sowie der Zuweisung 
von Farben und weiteren Attributen. 
 
Durch einen einfachen Mausklick auf den Button              wird das 3D-CAD Window aufgerufen. 
 
 

 
 
 

Bodyliste 

 
In der Bodyliste werden alle Namen der Geometrien zur aktuellen 
Gruppe angezeigt. 
 
Ein zweifacher Mausklick auf ein Listenelement gibt detaillierte 
Information zur Geometrie. 
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3D CAD Window 
 

 
 

Auswahl der Gruppe 

 

In EASY-ROB™ stehen drei Gruppen für die Erstellung von 
Bodies zur Verfügung. Sie können unabhängig voneinander 
bearbeitet und gespeichert werden. 
 
 
 
File → Save → Robotfile 
 Toolfile 
 Bodyfile 

 

 
 

Body Erstellen / Importieren 
 
 
 
 
 
 
 
 
 
 
 

 

Bodies können neu erstellt oder importiert werden.  

 
Eigenschaften der Geometrien 

 
 

 

Die Eigenschaft der aktuellen Geometrie kann durch Doppelklick 
geändert werden. 
  

#[Nummer]  Name 

[angebunden an Achse] ( 0 = Roboterbasis, 1-12 = aktive Achse 1, sonst 

= passive Achse) 

Skalierungswert der Geometrie 
 
Typ und Zustand 
 

RGB Farbwert  

Offsetposition und -orientierung  

 

Produkt aus Referenzposition und Offsetposition 
 

Referenzposition und Referenzorientierung 

Worldposition und -orientierung 

 

Änderungen speichern / zurücksetzen 
 

 
 

Wurde der aktuellen Geometrie eine neue Position zugewiesen,  
kann diese mit  Save  als Startposition gespeichert oder  
mit  Reset  verworfen werden. 

Import aus  
EASY-ROB™ 

3D-CAD Library 

Import vorhandenen 
3D-CAD Dateien. 
VRML I + II (97) Daten 
müssen vorab als IGP® 
Partfile gespeichert 
werden. 

Primitive Körper 
erstellen 
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3D CAD Window 
 

 

 
 

aktuelle Geometrie aus der 3D Szene löschen 

 

 
 

mergen des gewählten Körpers ( siehe dazu auch „Import von 
VRML“ in diesem Dokument) 

 

 
 

Verschieben des Bauteils in der Liste 

 
Position / Orientierung 

der Geometrie 
 
 

 
 
 
 
 
 
 
 
 

Die Position und Orientierung der aktuellen Geometrie kann im 
Frame Dialog verändert werden. 
 
 

 
Offset-Position Toff 

 
Referenz-Position  TRef 

 
Produkt aus Referenz-Position und Offset-Position  TRef * Toff 

 
Vom Weltkoordinatennullpunkt ausgehend. 

Check Box „Measure“ zum Öffnen  
des Navigator Windows 
 

 
Tipp: 

 

Im Navigator Window gemessene Werte 
werden können weiterverwendet werden, in  
dem beispielsweise für den Wert 877.337 
die Systemvariable $dx verwendet wird. 
Mühseliges abtippen oder gar merken  
entfällt. 
 

Dreht und verschiebt 
den Body um sein 
eigenes 
Koordinatensystem. 
 
Nach jeder Drehung 
um x, y oder z hat das 
Koordinatensystem 
eine andere 
Ausrichtung. 

Dreht und 
verschiebt den 
Body um das 
Weltkoordinaten-
System. 
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3D CAD Window 
 

 
Koordinatensysteme 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

z.B. Roboter 
 Achse 
 

Produkt aus 
Referenz- und 
Offset Position 

Referenz  
Position 

Offset Position 

World Position 

Geometrie 

Weltkoordinatensystem (0,0,0) 
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EASY-ROB™ Bedienungshinweise 

Dialoge & Windows 

Kinematics Window 

 

 
Das Kinematics Window dient dazu, einen einzelnen oder mehrere Roboter in der Arbeitszelle zu handhaben 
bzw. die Eigenschaften zu manipulieren.  
 
Aktiviert wird das Kinematics Window entweder über das Menü Robotics / Open Kinematics Window oder die 
Tastenkombination „Ctrl+K“ 
 

 
 

 

 
 

Die Liste enthält Informationen zum Zustand des gewählten Roboters wie: 
- Name 
- Attach to – Status 
- Position / Orientierung der Basis, des TCP’s und des Tools 

 
Hinweis: 
Mittels Doppelklick auf die Einträge können Werte geändert werden. 
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Kinematics Window 
 

 

 
Auswählen eines Roboters 
Mit       bzw.       wird zwischen zwei Robotern hin- und hergeschaltet  

 
 

Mit                        wird der folgende Dialog mit einer Liste aller in der 
Arbeitszelle befindlichen Roboter geöffnet: 
 

 
 

 

 
Re-Attachen eines Roboters 
 
Öffnet den folgenden Dialog: 
 

 
 
um den aktuellen Roboter an einen anderen „Link“ zu attachen.  
 

 

 
Auswählen eines Roboters 
 
Nach Aktivierung des Buttons kann ein Roboter direkt in der Arbeitswelt durch 
Auswahl mit der Maus aktiviert werden 
 

 

 
Laden eines weiteren Roboters 
 

 

 
Speichern des aktuell ausgewählten Roboters 
 

 

 

 
Roboter springt (Snap) an ausgewähltes Polygon oder Vertex 
Bei „Snap to poly“ wird die Normale berücksichtigt. 
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Kinematics Window 
 

 

 
„Entladen“ / Entfernen eines Roboters aus der Arbeitswelt 
 

 

 
Attribute des Roboters 
 
Nach Auswahl des Buttons öffnet sich der folgende Dialog um die dort 
genannten Eigenschaften zu verändern. 
 

 
 
 

 

 
Kinematik des Roboters 
 
Nach Auswahl des Buttons öffnet sich der folgende Dialog:  

 

 

 
Hier können kinematische Längen und Drehrichtungen verändert werden. 
 

 

 
Erzeugen eines weiteren Roboters 
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Kinematics Window 
 

 

 
Startbedingung speichern oder zurücksetzen 
 

 
 
 

 

 
„Refresh“ Aktualisierung der Daten in der Zustands-Liste 
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EASY-ROB™ Bedienungshinweise 

Dialoge & Windows 

Jog Window 

 

 
Das JogWindow dient dazu, den Roboter mit einer 3 Tastenmaus schnell und übersichtlich in den einzelnen 
Achsen oder im TCP bzgl. Werkzeug- oder Weltkoordinaten zu joggen bzw. zu manipulieren. Zusätzlich 
können die Verfahrbereichs- und Kollisionsüberwachung aktiviert werden. 
 

 
 

 

 

Die Liste enthält einige ERPL- und ERCL Beispielbefehle, 
 
wie Bewegungsbefehle LIN, LIN_REL, CIRC ... usw. 
 ERCL - Befehle Color, Track, Tag … usw. 
 
Weitere Befehle können der Liste hinzugefügt werden. 

 

Durch Eingabe, oder Doppelklick auf einen Befehl in der Liste, wird der Befehl 
in die Commandzeile übernommen. 
 

Mit         wird der Befehl an die aktuell markierte Stelle eingefügt. 
 

Mit         wird der aktuell markierte Befehl aus der Liste gelöscht. 
 

Mit          wird der Befehl in der Commandzeile ausgeführt. 

 

 
 

Die Achsen 1 bis 3 werden mit einer 3 Tastenmaus bewegt, indem die 
Maustaste gedrückt und die Maus gleichzeitig in der 3D Szene bewegt wird. 
 

Linke Maus-Taste  Achse 1 
Mittlere Maus-Taste Achse 2 
Rechte Maus-Taste Achse 3 
 

Mit der TAB-Taste werden die Achsen 4-6, 7-9 und 10-12 angewählt. 
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Jog Window 
 

 

 
 

 
Belegen der Achsen auf LMB  

 

 

 
Joggen der Achsen  
 
 

 

 

 

TCP-Bewegung bzgl. Werkzeugkoordinaten → TCP Tool Mouse-Mode. 
 
Diese Funktion entspricht dem Short-Key 
 

 

 
 

 

TCP-Bewegung bzgl. Weltkoordinaten → TCP World Mouse-Mode. 
 
Diese Funktion entspricht dem Short-Key 
 

 

 

 
Umschalten der TCP-Bewegung auf rotatorisch 

 

 
 

 
Auswahl des Roboters 

 

 

 
Einschalten Cruise Mode 
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EASY-ROB™ Bedienungshinweise 

Dialoge & Windows 

Tag Window 

 

 
Im Tag Window werden Pfade unabhängig voneinander generiert, bearbeitet und im Raum platziert. Ein Pfad 
besteht aus mehreren Tagpunkten und kann an eine Geometrie, an eine Roboterbasis oder –flansch 
angebunden „attached“ sein. Ändern sich Geometrie- oder Roboterposition, bewegen sich die angebundenen 
Pfade automatisch mit. Ausgewählt und bearbeitet werden können Tags einzeln oder als Gruppe. Die 
Tastenkombinationen „Str + A“, „Str + C“, und „Str + V“ können wie gewohnt verwendet werden. 
 
Das Tag Window wird mit einem einfachen Mausklick auf den Button „SEL TAG“ aufgerufen. 
 
 

 

mailto:info@easy-rob.com
http://www.easy-rob.com/


 

Technische Änderungen und Verbesserungen sind vorbehalten 77/109 

  
EASY-ROB Software GmbH  Hauptstr.42  65719 Hofheim am Taunus  Germany  Tel. +49 6192 921 70-77  Fax. +49 6192 921 70-66  info.er@easy-rob.com  www.easy-rob.com 
 

Tag Window 
 

TCP Jog  Der Roboter springt zum markierten Tagpunkt. 

Show cTag 

Es werden die Tagpunkte des ausgewählten Pfades mit farblich 
gekennzeichneten „Pfeilen“ miteinander verbunden. 
 

• violett:  vom Referenzsystem zum Wobj-Frame 
• grün:   vom Wobj-Frame zum 1. Tag 
• gelb:   vom 1. Tag zum folgenden (2.) Tag usw. 
• rot:   vom vorletzten Tag zum letzten Tag 

Measure Öffnet den Navigator Dialog  

Tagliste 
In dieser Liste werden alle Tags des aktuellen Pfades angezeigt. 
Mit zweifachem Mausklick auf einen Tag, wird er angefahren. 

 
 
                       Tagpunkt an 
                       Geometrie erzeugen. 

Es können Tagpunkte an Geometrien erzeugt werden. 
 

Maustaste links: Position auf der Geometrie auswählen 
Maustaste mitte:  neuen Tagpunkt am TCP erzeugen 
Maustaste rechts:  ausgewählten Tagpunkt platzieren 
 

Die Position an der Geometrie wird mittels rosa Pfeils angezeigt. 

 
Verschiebt in der Tagliste den markierten Tagpunkt, um eine 
Position nach oben bzw. nach unten. 

 

Vom ausgewählten Tag bis zum letzten Tag des Pfades fährt der 
Roboter die Tagpunkte nacheinander an. Die Bewegungsart wird 
mit dem Tagpunkt vorgegeben. 

 
Ausgewählten Tag anfahren, →  Doppelklick auf Tag in der 
Tagliste 

 Auswählen des nächsten oder vorigen Tags aus der Tagliste. 

 
Bewegungsart  
des Roboters 

 

Mit dem Button                        verfährt der Roboter zum 
 

markierten Tag. Die Bewegungsart kann wie folgt vorgegeben 
werden. 
 

Motype Attribute wie in Eigenschaften des Tag beschrieben ist 
PTP Bewegungsart PTP (Point to Point, synchro PTP) 
LIN Bewegungart  LIN  (linear) 

 
Tagpunkt-Eigenschaften 

 

 

Durch Doppelklick auf eine Tagpunkt-Eigenschaft kann diese in 
einem neuen Dialog verändert werden. 
#[Tagnummer] [Worldobjektname] [Pfad] : [Prefix] _ [Tagname] 

An welchen Body der Pfad angebunden  attached  ist 

Position des Workobject-Frames 

Orientierung des Workobject-Frames 

Position des Tag bzgl. Workobject-Frame 

Orientierung des Tag bzgl. Workobject-Frame 

Bewegungsart des Tags 

Geschwindigkeit in Tagpunkt. „0“ → nicht definiert 

Farbe des Tags 

Darstellung des Tags 

Größe des dargestellten Tag-Dreibeins 
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Tag Window 
 

 

 
 

# [Pfadnummer/Pfadanzahl]  [Pfadname] : [Workobjectname] 

   

cPath 
Erstellen, Bearbeiten, Löschen und Auswählen von Pfaden. 
„ReAttach“ →  Pfad an Geometrie oder Roboter anbinden. 
 
cTag 
Erstellen und Bearbeiten markierter Tags 

 

 

Position und die Orientierung des markierten Tags oder des 
Workobject-Frames können eingegeben und verändert werden. 
Entspricht einem Doppelklick in der Tagpunkt-Eigenschaftenliste 
„Tag Position“ 

 Pfad auswählen 

 

 
Pfad an eine Geometrie 
oder Roboter anbinden 
 
Wird die Geometrie bewegt, 
bewegt sich der Pfad 
automatisch mit. 

 

  Name des Pfades und des Workobject-Frames ändern 

    

Pfad klonen, erstellen und löschen 
Die Anzahl der zu klonenden Tags und der Abstand zum 
nächsten Tag wird vorgegeben. 

 
Neuer Tag wird an die aktuelle TCP Position des Roboters 
erstellt, entspricht mittlere Maustaste im „Pick a Tag“ Modus 

 Der aktuelle Tag „cTag“ wird an den TCP des cRobot verschoben 

  Ändern des Tagnamen [Prefix] _ [Tagname] 

  
Klonen Löschen des cTags 

  

  

Öffnet den Frame-Dialog zur Eingabe der  
Tag- oder Workobject-Position 
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Tag Window 
 

 
Aktiviert den MouseMode „sel Tag“   

Es erscheint  als Cursor 

   Auswahl „pick“ eines Tags in der 3D Szene → cTag 

  

 
Auswahl „pick“ eines Polygons oder eines Punktes mit dem LMB 
 
Hinweis:  
Durch drücken des MMB wird ein neuer cTag erzeugt. 
Durch drücken des RMB springt der cTag an diese  
„pick“-Position.  
 

 →

 

cTag springt (snap) an ausgewähltes Polygon oder Vertex 
Bei „Snap to Poly“ wird die Normale berücksichtigt 

 Aktualisiert die Daten des Tag Windows  
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Tag Window 
 

Erzeugen und Ausrichten von Tags 

 
Vorgehensweise beim Erstellen eines Pfades und Anbinden an eine Geometrie 

 

Geometrie erstellen 
 
3D-CAD Window  
 

Pfad auswählen ggf. Name des Pfades und Workobject-Frames ändern. 

Tag on TCP erstellen 

 

Der erste Tag wird an die aktuelle TCP-Position des Roboters 
platziert. 

Re Attach 

 
Auswahl 5 – Pick Body  
Geometrie anklicken, sie wird mit einer Bounding-Box umrahmt. 
Alle nachfolgend erstellten Tags des Pfades sind an die 
Geometrie angebunden und bewegen sich mit der Geometrie mit. 
Die Geometrie kann auch zum Roboter/Maschine, Werkzeug oder 
zum Werkstück gehören. 

Pick a Tag 

 

Weitere Tagpunkte können nun per Mausklick an der Geometrie 
erzeugt werden. 
 

Maustaste links LMB: Position auf Geometrie auswählen 
Maustaste mitte MMB:  neuen Tagpunkt am TCP erzeugen 
Maustaste rechts RMB:  ausgewählten Tagpunkt platzieren 
 
Mit der rechten Maustaste (RMB) wird der aktuell ausgewählte 
Tagpunkt an die Position platziert, die zuletzt mit der linken 
Maustaste (LMB) (Pick & Click) ausgewählt wurde. Die mittlere 
Maustaste (MMB) wird lediglich dazu benötigt um dem Pfad einen 
weiteren Tagpunkt hinzuzufügen. 
 
Ist der Mittelpunkt eines Polygons selektiert worden, wird dessen 
Normalenvektor als Approach-Komponente (i. d. Regel die Z-
Richtung) des Tagpunktes übernommen.  
Zur Berechnung der X- und Y-Komponente des Tagpunktes wird 
der VorgängerTag oder die aktuelle TCP-Stellung des Roboters 
verwendet. 
 
Ist ein Punkt an der Geometrie selektiert worden, wird als 
Orientierung des Tagpunktes die aktuelle TCP-Orientierung des 
Roboters verwendet. 
 
Tipp: Richten Sie den ersten Tag am Polygon aus oder fahren ihn 
mit dem Roboter an und richten diesen entsprechend aus. 
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Tag Window 
 

Koordinaten- und Bezugssysteme eines Pfades 

 

Ref. Pos. 

Referenzposition    • Weltkoordinatennullpunkt 
 • Roboterbasis 
 • Roboter Tip (Flansch) 
 • Roboter TCP 
 • Body/Geometrie 
 
Die Referenzposition des Pfades ist immer in Weltkoordinaten beschrieben und 
hängt davon ab, an welches Objekt der Pfad angebunden ist. Die Werte der 
Referenzposition ändern sich wenn sich beispielsweise die Geometrie oder 
Roboterbasis bewegen. 

 

Wobj. Pos. 

Workobject-Position „Wobj.Pos.“ 
 

Die Workobject-Position ist bzgl. Referenzposition beschrieben. 
 
Bei aktiven Show cTag  wird die Verbindung zwischen Referenzposition und  
Wobj.Pos. violett dargestellt. 

 

Tag Pos. 

Tag Positions 
 

Alle Tag-Positionen eines Pfades sind bzgl. Workobject-Position ausgedrückt. 
 
Bei aktiven Show cTag werden die Tagpunkte mit gelben Pfeillinien verbunden, 
wobei der Pfeil zum ersten Tag grün und zum letzten Tag rot gekennzeichnet ist. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Ref. Pos. 

PATH 

Weltkoordinatensystem (0,0,0) 

Wobj. Pos. 
Tag Pos. 

Tag Point 
"T_1" 

Tag Point 
"T_2" 

Tag Point 
"T_3" 

mailto:info@easy-rob.com
http://www.easy-rob.com/


 

Technische Änderungen und Verbesserungen sind vorbehalten 82/109 

  
EASY-ROB Software GmbH  Hauptstr.42  65719 Hofheim am Taunus  Germany  Tel. +49 6192 921 70-77  Fax. +49 6192 921 70-66  info.er@easy-rob.com  www.easy-rob.com 
 

  

mailto:info@easy-rob.com
http://www.easy-rob.com/


 

Technische Änderungen und Verbesserungen sind vorbehalten 83/109 

  
EASY-ROB Software GmbH  Hauptstr.42  65719 Hofheim am Taunus  Germany  Tel. +49 6192 921 70-77  Fax. +49 6192 921 70-66  info.er@easy-rob.com  www.easy-rob.com 
 

EASY-ROB™ Bedienungshinweise 

Dialoge & Windows 

Teach Window 

 

 
Mit dem Teach Window können Simulationsprogramme in ERPL der EASY-ROB™ Program Language 
und ERCL der EASY-ROB™ Command Language schnell und fehlerfrei erstellt werden. Die gewünschten 
Verfahr- und Simulationsbefehle werden automatisch zeilenweise eingefügt und können zum Testen 
schrittweise ausgeführt werden. Nach dem Abspeichern der erstellten Programmdatei kann das vollständige 
Programm simuliert werden. 
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Teach Window 
 

Bearbeitung der aktuellen Programmdatei 

 
Erneutes laden der aktuellen Programmdatei. Befehle im Programmfenster 
werden überschrieben. 

 
Lädt die aktuelle Programmdatei in einen Editor, entsprechend der Festlegung in 
der Konfigurationsdatei „config.dat“. 

 Erstellt eine neue leere Programmumgebung. 

 Speichert den Inhalt des Programmfensters in eine Programmdatei. 

 Überschreibt die geladene Programmdatei mit dem Inhalt des Programmfensters. 

 Lädt eine neue Programmdatei. 

 

 Entfernt das aktuelle Programm aus dem Roboter  

 Online Hilfe zum Teach Window. 

Edit-Zeile zur Ausführung eines Befehls 

 Edit-Zeile mit ERCL Befehl „ERC TRACK ON“ zum Einschalten der TCP Spur. 

 
Setzt den eingegebenen Programmcode an die markierte Position im 
Quellcodefenster. Überschreibt aktuellen Code. 

 Führt den Befehl in der Edit-Zeile als Single Step aus. 

Programmzeilen erstellen / bearbeiten 

 
Zeigt die aktuelle Zeilennummer im Quellcodefenster an. 
Durch Klick auf den Button kann eine neue Zeilennummer eingegeben werden. 

 
Der Stern nach der aktuellen Zeilennummer gibt an, dass der Programmcode 
geändert wurde. 

 

Fügt den eingegebenen Programmcode aus der Edit-Zeile an die markierte 
Position im Quellcodefenster ein. Der restliche Programmcode wird nach unten 
verschoben. 

 
Schneidet den aktuell markierten Programmcode aus. 
Der restliche Programmcode wird nach oben verschoben. 

 
Fügt den letzten Programmcode der mit Del ausgeschnitten wurde wieder ein, 
wobei der restliche Programmcode nach unten verschoben wird. 

 Kopiert die markierte Zeile in die Zwischenablage. 

 
Fügt an die markierte Zeile den Code aus der Zwischenablage ein. Der restliche 
Programmcode wird nach unten verschoben. 

 Kopiert die markierte Zeile in die Edit-Zeile zwecks Bearbeitung oder Ausführung. 

 Suche nach einem eingegebenen Text und der nächsten Position 
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Teach Window 
 

Verfahrbefehle entsprechend der aktuellen TCP-Position erzeugen 

 Fährt den Roboter an seine Home-Position. 

 Achsspezifischer Verfahrbefehl Synchro-PTP 

 Aktuelle TCP Position wird mit dem Verfahrbefehl Synchro-PTP programmiert. 

 Aktuelle TCP Position wird mit dem Verfahrbefehl LIN programmiert. 

 

Aktuelle TCP Position wird mit dem Verfahrbefehl VIA programmiert. 
Hierbei handelt es sich um den für die Kreisinterpolation erforderlichen 
Zwischenpunkt. 

 Aktuelle TCP Position wird mit dem Verfahrbefehl CIRC programmiert. 

Verfahrbefehle an Tag Punkten erzeugen 

 

Auswahl eines Roboters oder Tag-Punktes durch Anklicken in der 3D Szene mit 
der linken Maustaste. Der ausgewählte aktuelle Tag wird mit einem rosa Pfeil 
angezeigt. 
Der Robotername bzw. der Name und Pfad des aktuellen Tags stehen im Status 
Bar des Hauptfensters. 

 

Auswahl von Pfaden und Tags. 
Die ersten beiden <> Pfeile schalten die Pfade der Tag´s weiter, 
die zweiten beiden <> Pfeile schalten die Tag´s weiter. 
Name und Pfad des aktuellen Tags stehen im Status Bar des Hauptfensters. 

 
Roboter bewegt sich zum aktuellen Tag mit der Bewegungsart, die dem Tag-
Punkt zugewiesen wurde, siehe Tag Window. 

 Roboter bewegt sich in der Verfahrart Synchro-PTP zum aktuellen Tag. 

 Roboter bewegt sich in der Verfahrart LIN zum aktuellen Tag. 

 Der aktuelle Tag wird für eine CIRC Bewegung als Zwischenpunkt gespeichert. 

 
Roboter bewegt sich in der Verfahrart CIRC zum aktuellen Tag, wobei der VIA-
Punkt durchfahren wird. 

Programmieren weiterer Bewegungsbefehle 

 

 
Öffnet neuen Dialog mit zusätzlichen Bewegungsbefehlen. 
 
z.B. PTP_Rel, LIN_Rel.... usw. 
 
Erläuterung der einzelnen Bewegungsbefehlen stehen in 
der Dokumentation: „ERPL-/ERCL Programmiersprache“ 
und der Online Hilfe unter: Robot Motion Command 
 

mailto:info@easy-rob.com
http://www.easy-rob.com/


 

Technische Änderungen und Verbesserungen sind vorbehalten 86/109 

  
EASY-ROB Software GmbH  Hauptstr.42  65719 Hofheim am Taunus  Germany  Tel. +49 6192 921 70-77  Fax. +49 6192 921 70-66  info.er@easy-rob.com  www.easy-rob.com 
 

Teach Window 
 

 

 
 
 
Öffnet neuen Dialog mit Steuerbefehlen. 
 
z.B. Speed_CP, ACCEL_CP.... usw. 
 
Erläuterung der einzelnen Bewegungsbefehlen stehen  
in der Dokumentation:  
„ERPL-/ERCL Programmiersprache“in 
und in der Online Hilfe unter: Robot Control Command 
 

 

 
 
 
Öffnet neuen Dialog mit EASY-ROB™ Commandos. 
 
z.B. ERC COLLISION ON, ERC TRACK OFF... usw. 
 
 
Erläuterung der einzelnen Befehlen stehen in der  
Dokumentation: „ERPL-/ERCL Programmiersprache“ 
und in der Online Hilfe unter: 
ERCL  -  EASY-ROB™  Command  Language 

 

Führt den im Programmfenster markierten Befehl im Single Step (Einzelschritt) 
aus. 

 Kurzhilfe zur Erläuterung der Buttons im Teach Window. 

 Öffnet das Program Window, in dem alle ausgeführten Befehle angezeigt werden. 
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Teach Window 
 

 
Programmbeispiel: „KR30-2-TAGS.PRG“ 
aus „..\ EASY-ROB \ Tutorial \ Functional \ KR30-2-
Tags.cel“ 
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EASY-ROB™ Bedienungshinweise 

Dialoge & Windows 

CAD-Import Window 

 

 
EASY-ROB™ verwendet für den Datenimport das 3D_Evolution® API von CT CoreTechnologie GmbH.  
Der CT Kernel_IO wurde speziell für den Datenimport entwickelt, so dass CAD Formate aus verschiedenen 
CAD-Systemen importiert und optimiert werden können.  
 
Lesen Sie bitte zunächst das Kapitel „CAD Import (CT Kernel_IO) in der Installationsanleitung ! 
 
 
Nach dem Konvertieren einer CAD Geometrie wird diese automatisch in die CAD Preview geladen. 
Entsprechend der Anforderungen kann die Triangulierung des Bauteils (z.B. für die Datenreduktion) vom 
Bediener beeinflusst werden. Mit „Restore“ wird das Bauteil erneut konvertiert und für die Begutachtung 
wieder automatisch in die CAD Preview geladen.  
Für weitere Optimierungen stehen Funktionen wie das „mergen“, das „healing“ und das „sewing“ zur 
Verfügung. 
 
Alle erforderlichen Funktionen sind im CAD-Import Window zusammengefasst. 
 
Über das Menü „3D-CAD | Open CAD-Import Window“ wird das Fenster geöffnet. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

File | Load Laden und konvertieren von Daten in die Arbeitszelle 

File | Save Speichern der CAD Daten und der CAD-Import Message 

File | Unload Entladen der CAD Daten aus der CAD Preview 

Menü 

Information 

Datenhandling 

Triangulierung / 
Darstellung 

Zusatzfunktionen 

Messages 
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CAD-Import Window 
 

3D-CAD 
Funktionen zum Skalieren, Setzen der Position, Anzeigen der Kanten, mergen 
und Anzeige der Objektinformation 

Settings Anzeigen, Verändern und Zurücksetzen der Tesselierung 

FlexLM 
Starten, Stoppen des FlexLM für den CAD-Import 
Anzeigen des Logfiles und der Lizenz 

 
Laden und konvertieren von CAD Daten und automatisches laden in die CAD 
Preview 

 
Erneutes konvertieren der bereits geladenen Geometrie nach Beeinflussung der 
Triangulierungsparameter (Tessellation) und erneutes laden in die CAD Preview 

 Erneutes laden der konvertierten IGP Dateien  

 
Anzeige der Objektinformationen wie Dateiname und Pfad, Anzahl Objekte, 
Linien, Vertices, Polygone, Skalierung und Position 

 

 
Beim „Mergen“ wird intern die Anzahl der Objekte reduziert und die Anzahl der 
Polygone pro Objekt erhöht. So entstehen lange Polygonketten, die sich direkt in 
die Grafikkarte (VBO - Vertex Buffer Objects) laden lassen  
 

 

Veränderung der Triangulierung der Geometrie von Solids.  

 

 
 

Separate Beeinflussung der Polygongröße und des Winkels zwischen den 
Polygonen bei Solids 

 „Heilen“ des Objektes. Offene Geometrien werden nach Möglichkeit geschlossen. 

 
Zusammenfassen von Kanten, die innerhalb einer bestimmten Toleranz liegen. 

 
Die Originalfarben der Geometrie werden überschrieben. So kann die Farbe in 
EASY-ROB nachträglich geändert 

 
Berücksichtigung der Assembly-Struktur (Funktion derzeit nicht belegt) 

 
Warnungs-Stufe; “ausführlich“, „normal“ und „keine Warnung“  

 Schließen des CAD-Import Window 
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EASY-ROB™ Bedienungshinweise 

Mini Tutorial 

Erzeugen von Tagpunkten an 3D Geometrien 

 

 
Im Folgenden wird Schritt für Schritt beschrieben wie in EASY-ROB™ auf der Fläche oder an einem Punkt 
einer 3D Geometrie (Zylinder) Pfade und Tags erstellt werden. Pfade und Tagpunkte bleiben an der 
Geometrie, auch wenn diese die Position ändert. 
 
 
Hinweis: 
Lesen Sie auch den Bedienhinweise zu dem hier verwendeten Dialog  Tag Window und 3D-Cad Window. 
 

 
Schritt 1: 
 
 
Laden des Roboters aus dem TrainLib-
Verzeichnis: 
 
File / Load / Robot file  
 
 
Als Beispiel dient der Roboter 
ER431. 
 
../ EASY-ROB / TrainLib / ER431.rob 

 

 

 
Schritt 2: 
 
Laden des Tools aus dem TrainLib-
Verzeichnis: 
 
File / Load / Tool file 
 
Als Beispiel dient das Tool:  tool.tol 
 
 
../ EASY-ROB / TrainLib / tool.rob 

 
 

 

 

Tool 
Daten 

TCP 
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Tags an 3D Geometrien erzeugen 
 

Schritt 3: 
 
Zylinder (3D Geometrie) erstellen und 
im Raum positionieren 
 
Maße: 
Radius 200 mm 
High1 500 mm 
Radius Top 200 mm 
High2 500 mm 
 
 
Offset-Position: 
X 2000 mm 
Y       0 mm 
Z     50 mm 
Rx       0° 
Ry    -10° 
Rz       0° 

 

 

Schritt 4: 
 
Im TagWindow den Namen des 
Pfades und des Workobjektes 
festlegen: 
 
z.B. Pfad: Body 
       Wobj: Cylinder 

 

Schritt 5: 
 
Der neu erstellte Pfad soll nun dem 
Zylinder zugewiesen werden und sich 
mit der Position des Zylinders 
mitbewegen. 
 
Wählen Sie  ReAttach 
und  5 - Pick Body 
und klicken sie dann den Zylinder an. 
 
Die folgende Abfrage „Keep World 
Position“ beantworten Sie mit „Nein“. 
 
Der Pfad mit seinen Tagpunkten hängt 
nun am Zylinder. 
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Tags an 3D Geometrien erzeugen 
 

 
Schritt 6: 
 
Das Koordinatensystem des Zylinders 
hat eine andere Ausrichtung als das 
Koordinatensystem des TCP’s. 
 
Um den ersten Tagpunkt direkt aus der 
Oberfläche des Zylinderdeckels zu 
platzieren,  
 

- aktivieren Sie  Pick a Tag   und 
klicken mit der linken Maustaste 
(LMB) auf die gewünschte Fläche. 

- erzeugen einen neuen Tag am 
TCP des Roboters durch 
einmaliges klicken mit der 
mittleren Maustaste (MMB) 

- weisen dem Tag am TCP des 
Roboters durch einmaliges klicken 
mit der rechten Maustaste (RMB) 
die richtige Position am Zylinder 
zu. 

 
Ein Doppelklick auf den soeben 
erzeugten Tagpunkt im Tag Window 
lässt den Roboter zum Tagpunkt 
fahren. 
 

 
 
 
 

Maustaste links: Position auf der Geometrie auswählen 
Maustaste mitte: neuen Tagpunkt am TCP erzeugen 
Maustaste rechts: Tagpunkt an Geometrieposition 
 platzieren. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Schritt 7: 
 
Es sollen nun weitere Tagpunkte am 
Zylinder erzeugt werden. 
 
Öffnen Sie des Navigator Window : 

 
 

 
Schritt 8: 
 
Punkte an einer Geometrie selektieren 
 
 
Im Navigator Window 
Point Measure und Vertices  
einstellen. 
 
 
Sind  Vertices  aktiviert, werden die 
Eckpunkte aller 3D Geometrien durch 
gelbe Punkte angezeigt und können 
mit der linken Maustaste selektiert 
werden. 
 
 

 

  Zylinder mit  Vertices 

Ausrichtung des Tags an die Flächennormale 
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Tags an 3D Geometrien erzeugen 
 

 
Schritt 9: 
 
Um weitere Tagpunkte an den 
Eckpunkten des Zylinders zu 
erzeugen, die die gleiche Ausrichtung 
wie der erste Tagpunkt hat, muss der 
erste Tagpunkt vorab angefahren 
werden. 
 
Selektieren Sie nun mit der linken 
Maustaste (LMB) einen Punkt am 
Zylinder 
 
Erzeugen Sie mit der mittleren 
Maustaste (MMB)einen neuen 
Tagpunkt am TCP des Roboters. 
 
Weisen Sie dem Tag am TCP des 
Roboters durch einmaliges klicken mit 
der rechten Maustaste (RMB)die neue 
Position am Zylinderpunkt zu  
 
Die letzte Aktion bewirkt, dass der Tag 
vom TCP zum selektierten Punkt 
springt. 
 

 
Maustaste links: Position auf der Geometrie auswählen 
Maustaste mitte: neuen Tagpunkt am TCP erzeugen 
Maustaste rechts: Tagpunkt an Geometrieposition 
 platzieren. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

mailto:info@easy-rob.com
http://www.easy-rob.com/


 

Technische Änderungen und Verbesserungen sind vorbehalten 94/109 

  
EASY-ROB Software GmbH  Hauptstr.42  65719 Hofheim am Taunus  Germany  Tel. +49 6192 921 70-77  Fax. +49 6192 921 70-66  info.er@easy-rob.com  www.easy-rob.com 
 

EASY-ROB™ Bedienungshinweise 

Mini Tutorial 

Multi-KIN 

 
Beim Einsatz der Option “EASY-ROB™ Multi-KIN“ können beliebig viele Roboter-Kinematiken (*.rob-
Dateien) mit inverser kinematischer Lösung und mehr als drei Achsen in eine Arbeitszelle geladen und 
bewegt werden. Roboter bzw. Kinematiken mit bis zu drei Achsen, wie einfache Zuführeinrichtungen, 
Positionierer oder XYZ-Portale benötigen die Option “Multi-KIN“ nicht und können beliebig oft geladen 
werden. 
 
Mit der Option “Multi-KIN“ können sämtliche Roboter innerhalb derselben Simulation kartesische Punkte im 
Raum anfahren, so dass sowohl die Abläufe zwischen Robotern als auch zusammen mit Fördersystemen 
simuliert werden können. 
 
Es existiert nur ein Programm in der Arbeitszelle, das alle nötigen Befehle für alle Roboter beinhaltet. 
 
Als Beispiel dient die Arbeitszelle „tutorial_multi_kin.cel“ aus dem TrainLib-Verzeichnis. 
 
Hinweis: Bitte lesen Sie auch den Abschnitt „Teach Window“ in den allgemeinen Bedienungshinweisen  
 
 

 
        Beispielzelle: „tutorial_multi_kin.cel“ 
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Multi-KIN 
 

Vorgehensweise beim Arbeiten mit MultiKin (Arbeitzelle „tutorial_multi_kin.cel“) 

 
Für dieses Beispiel bitte die Arbeitzelle „tutorial_multi_kin.cel“ laden aus dem 
TrainLib-Verzeichnis.  

Kinematics Window 
öffnen 

 
über das Menü Robotics / Kinematics Window oder die Tastenkombination „Ctrl+K“ 
 

Roboter auswählen 
 
Mit den Pfeiltasten oder „sel Robot“ den Roboter „KR125-2“ aktiv 
setzen 

Teach Window 
öffnen  

neues Programm   

Zeile aktivieren 
 

active Zeile auf 10 setzen 

Defaults setzen  Set Default SPEEDs and ACCELs 

1. Roboter aktivieren  cRobot / SET / KR125-2 

Home Position   

Tag auswählen 

 

Tag Punkt T_BOX_1 auswählen 

Tag anfahren  Box anfahren 

Box greifen  GRAB [ ] / Grab „Bodyname“  /  BOX_1 

Linear wegfahren  LIN_Rel in Z um -1000 mm 

Tag auswählen 

 

Tag Punkt T_CONV_1auswählen 

Tag anfahren  T_CONV_1 anfahren 

Box loslassen  Release [ ] / Release „Bodyname“  /  BOX_1 

Linear wegfahren  LIN_Rel in Z um -200 mm 

Home Position   

Box bewegen  Move [ ] / Move_Rel „Bodyname“  /  BOX_1 in X=5200 
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Multi-KIN 
 

2. Roboter aktivieren  cRobot / SET / IRB6400_M97 

Tag auswählen 

 

Tag Punkt T_BOX_G_2 auswählen 

Tag anfahren  Tag Punkt T_BOX_G_2  anfahren 

Tag auswählen 

 

Tag Punkt T_BOX_G_1 auswählen 

Linear anfahren  Tag Punkt T_BOX_G_1 linear anfahren 

Box greifen  GRAB [ ] / Grab „Bodyname“  /  BOX_1 

Linear wegfahren  LIN_Rel in Z um -200 mm 

Tag auswählen 

 

Tag Punkt T_PALLETTE_2 auswählen 

Tag anfahren  Tag Punkt T_PALLETTE_2 anfahren 

Tag auswählen 

 

Tag Punkt T_PALLETTE_1 auswählen 

Linear anfahren  Tag Punkt T_PALLETTE_1 linear anfahren 

Box loslassen  Release [ ] / Release „Bodyname“  /  BOX_1 

Home Position   

Programm speichern   
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Multi-KIN 
 

EASY-ROB™ Bedienungshinweise 

 

Das Programm in der Übersicht 
 
 

ProgramFile 

 
! cRobot 'KR125-2' 
! Below section is called once at t=0 
! Add Initialization commands here 
!  
EndInit 
!  
! Below section is called at t>0 
! Add new ERPL / ERCL commands here 
! Set Default SPEEDs and ACCELs 
SPEED_PTP_AX    40.0000    40.0000    40.0000    40.0000    40.0000    40.0000 
ACCEL_PTP_AX    40.0000    40.0000    40.0000    40.0000    40.0000    40.0000 
SPEED_CP         0.2500 0.0 
ACCEL_CP         1.5000 
SPEED_ORI       20.0000 0.0 
ACCEL_ORI       40.0000 
OV_PRO         100.0000 
ERC NO_DECEL OFF 
ZONE             0.0000 
! --------- 
 
ERC CURRENT_DEVICE SET KR125-2 
Home 1 
MOVE T_BOX_1 
ERC GRAB BODY BOX_1 
LIN_REL  0.0000  0.0000  -1.000  0.0000  0.0000  0.0000 
MOVE T_CONV_1 
ERC RELEASE BODY BOX_1 
LIN_REL  0.0000  0.0000  -0.2000  0.0000  0.0000  0.0000 
Home 1 
 
ERC MOVE_REL BODY BOX_1  5.2000  0.0000  0.0000  0.0000  0.0000  0.0000 
 
ERC CURRENT_DEVICE SET IRB6400_M97 
MOVE T_BOX_G_2 
LIN T_BOX_G_1 
ERC GRAB BODY BOX_1 
LIN_REL   0.0000  0.0000 -0.2000  0.0000  0.0000  0.0000 
MOVE T_PALLETTE_2 
LIN T_PALLETTE_1 
ERC RELEASE BODY BOX_1 
Home 1 
 

EndProgramFile 

 

 
 
 
Programmbegin 
 
 
 
 
 
 
 
 
 
Geschwindigkeits-und Beschleunigungsdef. 
40 °/s für alle Achsen 
40 °/s² für alle Achsen 
250 mm/s 
1500 mm/s² 
20 °/s 
40 °/s² 
programmierter Override in [%] 
kein Abbremsen OFF, Halt im Zielpunkt  
Zonewert = 0 fine Punkt 
!-------- 
 
Roboter „KR125-2“ aktiviert 
Homeposition 1 anfahren 
Box anfahren 
Box greifen 
Linear wegfahren um 1000 mm in Approach 
Förderband anfahren 
Box loslassen 
Linear wegfahren um 200 mm in Approach 
Homeposition 1 anfahren 
 
Box relativ verfahren 
 
 
Roboter 2 aktiviert 
Box anfahren 
Linear anfahren 
Box greifen 
Linear wegfahren um 200 mm 
Palette anfahren 
Linear anfahren 
Box loslassen 
Homeposition anfahren 
 
Programmende 
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EASY-ROB™ Bedienungshinweise 

Mini Tutorial 

Trajektorienplanung und -Interpolation 

 

 
Die Trajektorienplanung hat die Aufgabe den Weg im kartesischen Raum vom Startpunkt A zum Zielpunkt B 
so zu planen, dass die Interpolation pro Zeiteinheit Zielvorgaben für den Roboter erzeugt. Für die 
Trajektorienplanung stehen die Verfahrarten Synchro-PTP, SLEW, LIN und CIRC zur Verfügung. Im 
Folgenden soll auf den Zusammenhang zwischen Positions- und Orientierungsinterpolation eingegangen 
werden und das daraus resultierende unterschiedliche Zeit- und Bewegungsverhalten. 
 
Um den Weg von Punkt A zu Punkt B zu planen sind folgende Vorgaben nötig 
 

- Start- und Zielposition mit Orientierung 
- Bahn- und Orientierungsgeschwindigkeit, sowie Beschleunigungen 
- Verfahrart 
- Zusammenhang zwischen Positions- und Orientierungsführung 

 
Im folgenden Beispiel sind an einem Rechteck 4 Punkte programmiert, wobei jeweils zwei der vier Punkte 
eine gleiche Orientierung haben. Die Punkt- oder Tagkoordinaten T2 - T5 sind in der folgenden Tabelle 
eingetragen. 
 

Tag X [mm] Y [mm] Z [mm] Rx [°] Ry [°] Rz [°] 

T2 250 500 300 0 180 0 

T3 1250 500 300 0 180 0 

T4 1250 0 300 -45 180 0 

T5 250 0 300 45 180 0 

 
Um entlang der Kante des Rechtecks zu fahren wird die Verfahrart LIN gewählt. In Abhängigkeit von der 
gewählten Interpolationsart für die Orientierung und der Position werden sich verschiedene Taktzeiten 
ergeben. Die nächste Tabelle zeigt die Wegabstände und die Orientierungswinkeldifferenzen zwischen den 
Tagpunkten. 
 

von - nach Weg Winkel 

T2 - T3 1000 mm   0° 

T3 - T4 500 mm  45° 

T4 - T5 1000 mm -90° 

T5 - T2 500 mm  45° 

 
 
 
 
 
 
 
 
 
 

T2 T3 

T4 T5 

x 

y 
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Trajektorienplanung und -Interpolation 
 

 
 
In dem Beispiel  
motion_planning_01.cel  und dem  
Verfahrprogramm  
motion_planning_01.prg  
(aus der TrainLib) soll der  
KUKA Roboter vom Typ KR 125-2  
die Ergebnisse darstellen. 
 
 
 
 
 
 
 
 
 
 

 
ProgramFile 
 
SPEED_PTP_AX  20.00   20.00   20.00   20.00   20.00   20.00 
ACCEL_PTP_AX  10.00   10.00   10.00   10.00   10.00   10.00 
SPEED_CP         0.2000 0.0 
ACCEL_CP         0.1000 
SPEED_ORI       10.0000 0.0 
ACCEL_ORI       10.0000 
 
ZONE             0.0000 
 
LIN T_2 
! ------------------------------------------- 
ERC STATUS_OUTPUT ON  1  fname.dat 0 
 
! ------------------------------------------- 
LIN_ORI QUATERNION 
LEADING_POSITION ON 
!LEADING_ORIENTATION ON 
!LEADING_POSITION VAR 
 
call move() 
 
ERC STATUS_OUTPUT OFF 
! ------------------------------------------- 
PTP T_1 
EndProgramFile 
! ------------------------------------------- 
fct move() 
SPEED_CP         0.2000 0.0 
LIN T_3 
LIN T_4 
SPEED_CP         0.1000 0.0 
LIN T_5 
LIN T_2 
endfct 

 

 
Programmbegin 
Geschwindigkeits- und Beschleunigungsdefinitionen 
20 °/s  für alle Achsen 
10 °/s²  für alle Achsen 
200 mm/s  Bahngeschwindigkeit 
100 mm/s²  Bahnbeschleunigung 
10 °/s  Bahn-Orientierungsgeschwindigkeit 
10 °/s²  BahnOrientierungsbeschleunigung 
 
Zone = 0  -> exaktes Anfahren der Zielstellung, fine Punkt 
 
Fahre zur Startposition T_2 
! ------------------------------------------- 
Schreibe die Positionen und Geschwindigkeiten  in die 
Ergebnisdatei fname.dat 
! ------------------------------------------- 
Interpolation der Orientierung nach Quaternionen 
1. Versuch Orientierungs-Interpolationsart: Position 
2. Versuch Orientierungs-Interpolationsart: Orientierung 
3. Versuch Orientierungs-Interpolationsart: Variable 
 
Fahre entlang des Rechtecks nach T_3, T_4, T_5 und T_2 
 
Schließe die Ergebnisdatei fname.dat 
! ------------------------------------------- 
 
Programmende 
! ------------------------------------------- 
Begin der Funktion move() 
Fahre mit 200mm/s zu T_3 und T_4 
 
 
Fahre mit 100mm/s zu T_5 und T_2 
 
 
Ende der Funktion move() 
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Trajektorienplanung und -Interpolation 
 

 
Drei Orientierungs-Interpolationsarten 
 
Bei der Bahnplanung werden Position und Orientierung vorerst unabhängig voneinander geplant. Hieraus 
ergeben sich in der Regel unterschiedliche Ausführungszeiten. In der Praxis ist es erstrebenswert, dass  
Position und  Orientierung synchron interpoliert werden. Die Orientierungsinterpolationsart legt nun fest 
welche der geplanten Ausführungszeiten dominant sein soll. 
 
 
LEADING_POSITION ON Die Ausführungszeit wird durch die Position bestimmt. Nur wenn 

diese 0 ist, ist die Ausführungszeit die sich aus der Orientierung 
ergibt dominant. Bei kleinen Ausführungszeiten können die maximal 
zulässigen Orientierungsgeschwindigkeiten überschritten werden, 
was in der Regel zu überhöhten Gelenkgeschwindigkeiten und -
Beschleunigungen führt. 
 

LEADING_ORIENTATION ON Die Ausführungszeit wird durch die Orientierung bestimmt. Nur wenn 
diese 0 ist, ist die Ausführungszeit die sich aus der Position ergibt 
dominant. Bei kleinen Ausführungszeiten können die maximal 
zulässigen Positionsgeschwindigkeiten überschritten werden, was in 
der Regel zu überhöhten Gelenkgeschwindigkeiten und -
Beschleunigungen führt. 
 

LEADING_POSITION VAR Das Zeitverhalten ist Variable und wird durch die jeweils größere 
Ausführungszeit bestimmt. Eine Überschreitung der maximal 
zulässigen Gelenkgeschwindigkeiten und -Beschleunigungen wird 
abgesehen in der Nähe von singulären Stellungen vermieden. 
Nachteil: Die Prozessgeschwindigkeit ist nicht konstant. Diese 
Orientierungs-Interpolationsart ist somit nicht praxisrelevant für 
Applikation wie Kleben, Schneiden, Fräsen, bei denen der Roboter 
entlang eine Kontur mit konstanter Geschwindigkeit verfahren soll. 

 
 
Die gesamte Ausführungszeit „total Time“ für die drei Orientierungs-Interpolationsarten werden im  
Robot IO Output Window  „current Motion Data“  angezeigt. 
 
 
Entlang der Kontur des Rechtecks ergeben sich folgende verschiedene Ausführungszeiten. 
 
 LEADING_POSITION   ON 28,5 s 
 LEADING_ORIENTATION   ON 28,0 s 
 LEADING_POSITION   VAR 29,5 s 
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Trajektorienplanung und -Interpolation 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
LEADING_POSITION  ON: 

 
a) Für den Weg von T_2 nach T_3 mit spos = 1000 mm werden bei einer programmierten 
Geschwindigkeit von vpos = 200 mm/s und einer Beschleunigung von apos = 100 mm/s² insgesamt 
ts_pos = 7 Sekunden benötigt.  
 
 Beschleunigungszeit  tr1 = v/apos = 2,0 sec   sr1 = vpos

2/2apos = 200 mm 
 Bremszeit  tr2 = v/apos = 2,0 sec   sr2 = vpos

2/2apos = 200 mm 
 Konstantverfahrzeit tc = (spos - s r1 - s r1)/v = 3,0 sec  
 Gesamtverfahrzeit  ts_pos = tr1 + tc + tr2= 7,0 sec 
 
b) Für den Weg von T_3 nach T_4  mit spos = 500mm ergibt sich bei gleicher Berechnung  
ts_pos =4,5 Sekunden.  

Für die Winkeländerung von  = 45° ergeben bei einer programmierten Orientierungsgeschwindigkeit 
von vori = 10 °/s und einer Orientierungsbeschleunigung aori = 10 °/s² insgesamt ts_ori = 5,5 Sekunden 
 

 Beschleunigungszeit  tr1 = vori/aori = 1,0 sec    r1 = vori
2/2aori = 5° 

 Bremszeit  tr2 = vori/aori = 1,0 sec    r2 = vori
2/2aori = 5° 

 Konstantverfahrzeit tc = ( -  r1 -  r1)/vori = 3,5 sec  
 Gesamtverfahrzeit  ts_ori = tr1 + tc + tr2= 5,5 sec 
 
Fall b) zeigt, dass die Ausführungszeit ts_ori mit 5,5s größer ist, als die Ausführungszeit ts_pos mit 4,5s 
die sich aus der Positionsrechnung ergibt. In diesem Fall „LEADING_POSITION  ON“ wird die 
kleinere Ausführungszeit verwendet. 
 

LEADING_ORIENTATION   ON: 
Die Betrachtung von Fall b) ergibt entsprechend der vorstehenden Berechnung für die 
Orientierungsinterpolation eine Ausführungszeit von 5,5s, die hier dominant ist und verwendet wird. 

 
LEADING_POSITION   VAR: 

Bei dieser Orientierungs-Interpolationsart wird stets die größte Ausführungszeit verwendet. Somit 
ergibt sich in der Summe auch die größte gesamte Verfahrzeit. 
 

T_2 T_3 

T_4 T_5 

POS ON - 7,0 s 
ORI ON - 7,0 s 
POS VAR - 7,0 s 

POS ON - 4,5 s 
ORI ON - 5,5 s 
POS VAR - 5,5 s 

POS ON - 11,0 s 
ORI ON - 10,0 s 
POS VAR - 11,0 s 

POS ON - 6,0 s 
ORI ON - 5,5 s 
POS VAR - 6,0 s 
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Trajektorienplanung und -Interpolation 
 

 
Ergebnisdatei „fname.dat“ 
 
Mit der Programmzeile „ERC STATUS_OUTPUT ON  1  fname.dat  0“ wird die Ergebnisdatei „fname.dat“  
im aktuellen Ordner erstellt. In jedem Simulationsschritt werden die kartesischen Positionen, Gelenkwinkel 
und Gelenkwinkelgeschwindigkeiten aufgezeichnet. Die Programmzeile ERC STATUS_OUTPUT OFF   
beendet die Aufzeichnung und schließt die Ergebnisdatei. 
 
Erläuterung der Spalten in der Ergebnisdatei: 
 
 Spalte  1 :  laufende Nummer 
 Spalte  2 :  Zeit 
 Spalte  3 :  Position X in mm 
 Spalte  4 :  Position Y in mm 
 Spalte  5 :  Position Z in mm 
 Spalten  6-11: Gelenkwinkel der Achsen 1 bis 6 in [°] 
 Spalten  12-17:  Gelenkwinkelgeschwindigkeiten der Achsen 1 bis 6 in [°/s] 
 
Die Ergebnisdatei wurde für die Bewegung von T_2 bis T_5 für die Orientierungs-Interpolationsart 
LEADING_POSITION ON in ein Tabellenkalkulationsprogramm importiert, um die kartesischen 
Geschwindigkeiten und Beschleunigungen für die X- und Y-Richtung grafisch darzustellen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Die Verläufe zeigen ein ruckfreies und -stetiges Geschwindigkeits- und Beschleunigungsprofil. 
 
Hinweis:  Die berechnete maximale Beschleunigung ist mit 150 °/s² um 50% höher als die  

programmierte Beschleunigung mit 100 °/s². 

-200,00

-150,00

-100,00

-50,00

0,00

50,00

100,00

150,00

200,00
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-50,00
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50,00
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Trajektorienplanung und -Interpolation 
 

 
Hinweis: 
 
Um in EASY-ROB™ „ruckfreie“ Bahnbewegungen zu berechnen sind folgende Einstellungen vorzunehmen. 
 
 
 
Menu -> Robotics -> cRobotMotion Planner 
 
 Ipo Joint Code 
 Ipo CP Code 
 Ipo Circ Code 
 
 
 
 
 
 
 
 
 
Wählen Sie für den “Ipo CP Code API-IPO“  die Einstellung  “2 - Jerkfree Vel-Prof. C3“ . 
 
 
 
 
1 - Geometric Vel-Prof. C0 Ohne Geschwindigkeitsprofil, 

Beschleunigung und Ruck sind  
nicht begrenzt. 
 

2 - Jerkfree Vel-Prof. C3 Ruckfreier Geschwindigkeitsverlauf, 
Beschleunigung und Ruck sind  
stetig und begrenzt. 

 
 
 
Beispieldateien: 
 
 motion_planning_01.cel 
 motion_planning_01.prg 
 fname.xls 
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EASY-ROB™ Bedienungshinweise 

Multi-Program 

Verwendung digitaler Signale 

 

 
Bei Simulationen mit mehr als einem Programm in der Arbeitszelle (Multi-Program), müssen die Devices 
miteinander kommunizieren. Dies erfolgt in EASY-ROB™ mittels digitaler Signale. 
Im Grunde ist die Programmierung mit digitalen Signalen nicht sehr komplex. Das kann sich aber sehr 
schnell ändern, wenn entweder die Arbeitszelle und damit die Anzahl der kommunizierenden Programme 
wächst oder der Programmierer generell ein paar einfache empfohlene Grundregeln außer Acht lässt. 
 
 
Empfohlene Grundregeln: 
- Initialisieren Sie die Signale immer am Anfang des jeweiligen Roboterprogramms im 

Initialisierungsbereich. 
- Setzen Sie die Signale bei der Initialisierung immer auf Null (aus) 
- Verwenden Sie bei der Namensvergabe für die Signale „sprechende Namen“ – das erleichtert die 

Übersicht 
- Programmieren Sie die Kommunikation Schritt für Schritt bzw. immer nur ein Device-Paar und 

überprüfen Sie sofort ob die Kommunikation einwandfrei und wie gewünscht funktioniert. 
 
 
Arbeiten Sie immer nach folgendem Grundsatz: 

1. Wenn das Signal nicht gesetzt ist - dann setzt Device „A“ sein Signal 
2. Device „B“ wartet solange bis das Signal von Device „A“ gesetzt ist und 
3. Device „B“ setzt umgehend das Signal von Device „A“ zurück. 

 
 
 
In den folgenden Programmausschnitten wird die Vorgehensweise verdeutlicht: 

1. Der Roboter setzt einen Gegenstand auf dem Förderband ab 
2. Wenn das Roboter Signal nicht gesetzt ist, dann setzt der Roboter das Signal auf „1“ und teilt so 

dem Förderer mit, das der Gegenstand da ist 
3. Der Förderer wartet auf das Signal vom Roboter 
4. Der Förderer setzt nach Erhalt des Signals das Signal des Roboters sofort zurück 
5. Der Förderer nimmt den Gegenstand mit, kommt zurück und lässt los 
6. Der Förderer setzt sein Signal auf „1“ und teilt dem Roboter mit, das er wieder da ist 
7. Der Roboter wartet auf das Signal vom Förderer 
8. Der Roboter setzt nach Erhalt des Signals das Signal des Förderers sofort zurück 
9. Der Roboter nimmt den Gegenstand und fährt weg 
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Multi-Program – Verwendung digitaler Signale 
 

Beispiel 

Roboterprogramm (Ausschnitt) Förderbandprogramm (Ausschnitt) 

…..  
1. ERC RELEASE DEVICE BOX_TUTORIAL  
2. WAIT_UNTIL_SIGNAL_UNSET rob01_out  
2. rob01_out=1 3. WAIT_UNTIL_SIGNAL_SET rob01_out 
 4. rob01_out=0 
 5. ERC GRAB DEVICE BOX_TUTORIA 
 5. PTP T_CONV_2 
 5. PTP T_CONV_1 
 5. ERC RELEASE DEVICE BOX_TUTORIAL 
 6. WAIT_UNTIL_SIGNAL_UNSET conv_out 
7. WAIT_UNTIL_SIGNAL_SET conv_out 6. conv_out=1 
8. conv_out=0  
9. PTP T_BOX_TOP_1  
9. ERC GRAB DEVICE BOX_TUTORIAL  
…..  
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EASY-ROB™  Bedienungshinweise 

 

Internet Links 
 
- EASY-ROB™  

 
Link: https://easy-rob.com/downloads/ 
 
Bedienhinweise zu EASY-ROB™ 
 bedienungs-hinweise.pdf 
 
Bedienhinweise Spezielle Funktionen und PlugIns zu EASY-ROB™ 
 bedienungs-hinweise-funktionen-plugins.pdf  
 
ERPL/ERCL - EASY-ROB™ Program Language 
 easy-rob-erpl_de.pdf 
 

- EASY-ROB™ Newsletter 
 
Link: https://easy-rob.com/downloads/ 

 
Jahr 2018 
Thema: Release 7.6 – Die neue Version update-info-v76.pdf 
 
Jahr 2017 
Thema: Release 7.3 – Die neue Version update-info-v73.pdf 
 
Jahr 2016 
Thema: Release 7.0 – Die neue Version update-info-v70.pdf 
 
Jahr 2015 
Thema: Release 6.6 – Die neue Version update-info-v66.pdf 
 
Jahr 2014 
Thema: Release 6.3 – Die neue Version update-info-v63.pdf 
 
Jahr 2012 
Thema: Release 6.0 – Die neue Version news-04-12-d.pdf 
 
Jahr 2011 
Thema: Release 5.6 – Die neue Version news-04-11-d.pdf  
 
Jahr 2010 
Thema: Release 5.3 – Die neue Version news-02-10-d.pdf  
 
 Jahr 2009 
Thema: Release 5.006 – Update news-07-09-d.pdf  
 
3./4. Quartal 2008 
Thema: Release 5.0 – Die neue Version news-10-08-d.pdf  
 
1./2. Quartal 2008 
Thema: Release 4.606 – Project Manager news-03-08-d.pdf  
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http://www.easy-rob.com/uploads/media/easy-rob-erpl_de.pdf
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http://www.easy-rob.com/uploads/media/Update-ER_v7605-2018_DE_01.pdf
http://www.easy-rob.com/uploads/media/Update-ER_v7305-2017_DE_01.pdf
http://www.easy-rob.com/uploads/media/Update-ER_v7004-2016_DE_01.pdf
http://www.easy-rob.com/uploads/media/update-er_v6601-2015_de.pdf
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Internet Links 
 

4. Quartal 2007 
Thema: Release 4.603 – Multi-Program news-11-07-d.pdf 
 
3. Quartal 2007 
Thema: Release 4.307 - Update news-08-07-d.pdf  
 
1./2. Quartal 2007 
Thema: Release 4.305 - Die neue Version news-01-07-d.pdf 
 
3./4. Quartal 2005 
Thema: Neue Multi-Möglichkeiten für Multiple Kinematik news-09-05-d.pdf  
 
1./2. Quartal 2005 
Thema: Release 4.0 bringt Multiple Kinematik news-03-05-d.pdf  
 
3./4. Quartal 2004 
Thema: API für individuelle Kundenlösungen news-10-04-d.pdf  
 
2. Quartal 2004 
Thema: EASY-ROB™ Robotics Simulation Kernel  
in Offlineprogrammiersystem FAMOS integriert news-06-04-d.pdf  
 
1. Quartal 2004 
Thema: Videomodus für Simulationen news-03-04-d.pdf  
 
4. Quartal 2003 
 Ihr neuer Begleiter – EASY-ROB News news-11-03-d.pdf 

 
- Prof. Dr. Thomas Horsch: 

Introduction to Robotics: „Module Trajectory generation and robot programming” 
FH Darmstadt, Summer 2000,  
Link: http://www.easy-rob.com/service/artikel-publikationen.html 
 LectureRobotics.pdf 
 

- Prof. Heribert Münch, Dipl.-Ing. J. Bargfrede: 
„Universelle Koordinatentransformation für Industrieroboter“ 
Hochschule Magdeburg-Stendal, August 2001,  
Link: http://www.easy-rob.com/service/artikel-publikationen.html 
 paper_unitrans.pdf 
 

- Janko Härtig: Praktikumsarbeit bei EASY-ROB™ 
Roboterkinematiken „Direkte- und inverse Koordinatentransformation“ 
Hochschule Mittweida (FH), Juli 2004,  
Link: http://www.easy-rob.com/service/artikel-publikationen.html 
 bps-inverse-kinematik-jhaertig.pdf 
 

- Dipl.-Ing. S. Anton: 
„Inverse Kinematik am Robotersimulationsprogramm EASY-ROB™“ 
1. Workshop Robotik, Hochschule Mittweida (FH), Oktober 2004,  
Link: http://www.easy-rob.com/service/artikel-publikationen.html 
 EASY-ROB-Inverse-Kinematik.pdf 
 
Institut für Automatisierungstechnik, Hochschule Mittweida (FH) 
Link:  http://www.global.hs-mittweida.de/~ifa/archivrobotik.htm 
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EASY-ROB™  

 

Kontakt 
 

 

 
 

EASY-ROB  Software GmbH 
 

Adresse:  Hauptstr. 42 

   65719 Hofheim am Taunus 

   Germany 

 

Kontaktperson: Stefan Anton 
 

Tel.:   +49 (0) 6192  921 70 77 

FAX.:   +49 (0) 6192  921 70 66 

 

Email:   contact@easy-rob.com 

   sales@easy-rob.com 

 

Url:   www.easy-rob.com 

 

 

EASY-ROB Kundenbereich 
 
Inhalte:  Programm-Updates und Roboter Bibliotheken 

 
Web-Adresse: www.easy-rob.com/downloads/kundenbereich/ 

 
Zugangsdaten: 
   Benutzer: customer 

   Passwort: ********** 
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EASY-ROB™  

 

Platz für Ihre Notizen 
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